


Site Analyst Overview

Welcome to Microsoft Site Analyst, the best way to manage your Web site. Whether you’re a 
Webmaster, an information architect, or a site publisher, Microsoft Site Analyst gives you the tools
you need to solve your site management problems.

What’s new in this release

· Two views of the same map. In addition to the Tree view (the linear, hierarchical view of the
map), the Cyberbolic view depicts the map items in a web-like structure that emphasizes 
their interconnected nature. You can choose to see either view or both views at the same 
time.

· HTML reports and a hyperlinked HTML Help system for the reports. The HTML reports 
let you analyze your site resources, track changes to your site, and find broken links. 
Because you view the reports in your browser, you may want to include some of them, such 
as the hierarchy or index reports, in your site as navigational aids. Site Analyst’s reports are 
linked to each other, and they are linked to the site resources.

· Quick Searches. A set of predefined searches is included with Site Analyst. You can also 
customize your own quick searches.

· More properties to use for search criteria.
· A new Results window. When you perform a Search or Compare and Update operation, the

results window appears with properties arranged in columns. You can choose which 
properties to include and how you want to arrange the columns. You can even export the 
information to HTML or to a spreadsheet or database.

· A new Link Info window. Each object in the map has associated link information, which Site
Analyst displays in the Link Info window. Like the Results window, you can arrange properties
and columns, and you can export the information to HTML or to a spreadsheet or database.



Microsoft Site Analyst Contents

Enter the world of cyberspace cartography and Web site management with Microsoft Site 
Analyst. Click any underlined title to jump to the subject of your choice.

Overview : A brief overview of Site Analyst and what’s new in this release.

Mapping Tasks : A hyperlinked list of the most common tasks you can perform in Tree view 
and Cyberbolic view.

Cyberbolic Tasks : A hyperlinked list of the tasks you can perform specifically in Cyberbolic 
view.

Dialog boxes : A hyperlinked list of the Site Analyst dialog box descriptions.

Glossary: Definitions of terms, in alphabetical order.

Toolbar: Descriptions of the Main and Cyberbolic toolbar buttons.

Keyboard 
Shortcuts:

Lists the menu equivalents of menu commands.

Menu Commands: Descriptions of each menu command.



How to use Site Analyst Help

The Microsoft Site Analyst Help system has been designed and built using the Microsoft 
Windows 95 Help compiler and RoboHelp 95. If you are familiar with the Windows 95 Help 
system, you should feel right at home with the Site Analyst Help system! Here are a few tips for 
using Site Analyst Help:

The Browse buttons and Back button

This Help system has browse buttons so you can navigate through a sequence of topics within 
each major section. The browse buttons are at the top of each Help screen. Press the forward 
browse button  to move forward through the Help topics, and the back browse button to move 
backward. When you reach either the end or the beginning of each sequence, the appropriate 
button is disabled.

The Back button is useful when you are jumping around in the Help system in a random manner. 
Use the Back button to return to the previous screen.

Jumps and glossary popups

Whenever you see a green solid, underlined word or phrase, when you click it, it will jump you to 
that topic. For example, if you want to see the Overview , just click that words now and see what 
happens. Hint: Be sure to click the Back button on this screen to get back here.

Whenever you see a green dashed, underlined word, when you click it, a popup window appears 
with a definition of that word. For example, click this word: WebMap.

Pressing F1

You can press F1 for Help on all the menu items and dialog boxes.

Custom contents screen

In addition to the Microsoft Windows Help topics dialog box, Site Analyst has a custom contents 
screen. You can access the contents screen in one of three ways:

· Click the large question mark on the Site Analyst toolbar.
· Choose Help|Contents on the menu bar.
· Choose Help|Topics and click Site Analyst Contents.



Glossary

      {button A,JI(`WMAPPER.HLP',`A')}{button B-C,JI(`WMAPPER.HLP',`B_C')}{button D-
E,JI(`WMAPPER.HLP',`D_E')}{button F,JI(`WMAPPER.HLP',`F')}{button 
G,JI(`WMAPPER.HLP',`G')}{button H,JI(`WMAPPER.HLP',`H')}{button 
I,JI(`WMAPPER.HLP',`I')}{button J-L,JI(`WMAPPER.HLP',`J_L')}
{button M,JI(`WMAPPER.HLP',`M')}{button N-O,JI(`WMAPPER.HLP',`N_O')}{button P-
Q,JI(`WMAPPER.HLP',`P_Q')}{button R-S,JI(`WMAPPER.HLP',`R_S')}{button T-
U,JI(`WMAPPER.HLP',`T_U')}{button V-W,JI(`WMAPPER.HLP',`V_W')}{button X-
Z,JI(`WMAPPER.HLP',`X_Z')}
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Alt string (for images)
An optional text string that a Webmaster might include with an HTML IMG tag, which is used to 
describe the associated image. For example, for an image of a waterfall, the ALT string might 
read: "GIF image of waterfall." The ALT string allows people who use text-only browsers or who 
have chosen not to download images, to know what the image depicts. In Site Analyst, the ALT 
attribute is a property you can examine in the image's Properties dialog box.



alternate route
A secondary occurrence of a page or other object in a WebMap, shown with a green label. When 
you see an alternate route, it means the object is pointed to by more than one hyperlink.



application
In a WebMap, Java™ applets, EXE files, PDF files, Microsoft Word documents, and other 
applications.



broken link
A reference to a resource that Site Analyst cannot locate, because the URL is not valid, the 
resource the link points to doesn’t exist, or the server containing the resource is busy or having 
other technical difficulties.



CGI bin directory
The directory on a server where CGI script programs are stored. For Site Analyst, you specify the
location of the CGI bin directory when you use the New command to map a site located on a 
local or networked file system.



CGI (Common Gateway Interface) script
A program that allows a server to communicate with users on the Internet. For example, when 
you enter information in a form on a Web page, a CGI script interprets the information you enter 
and communicates it to a database program on the server.



child
An object that appears below the selected object in the Tree view (because there is a link to it on 
the selected object—its parent). For example, any objects pointed to by hyperlinks on the home 
page are represented in the WebMap as "children" of the home page.



collapse
In Tree view, to hide from view all children of the selected object, either by clicking the minus 
control icon, or by using the Expand command.



Cyberbolic view
The “pane” on the right side of the Microsoft Site Analyst map window. This view shows the site 
as an interconnected web of pages and other resources.



default file
The page (file) that is automatically shown when you access a URL that ends with a directory 
specification. Usual file names for the default file are default.htm/html, index.htm/html, or 
welcome.htm/html. You enter the name for the default file when you create a new map.



default.wmp
A WebMap of a site, placed in the site’s root directory by the Webmaster. When you first create a 
map, Site Analyst checks to see if there is already a default.wmp file on the site.



domain name
A text representation of a resource's IP address, using the unique name of the server computer, 
plus the kind of operation it's involved in—such as .com for a business or .edu for an academic 
institution. Domain names may have several parts, separated by periods. For example, 
www.microsoft.com is the domain name for the Microsoft site, where www.microsoft is the unique
name for the Microsoft server on the World Wide Web, and com is the type of activity the 
company is involved with (in this case, a commercial business).



expand
In Tree view, to show all immediate children of the selected object, either by clicking the plus 
icon, or by using the Expand command.



explore
To retrieve a resource via its URL. If the resource is a page that contains links to other resources,
exploring the page also looks up the URLs for those linked resources. Site Analyst explores a 
resource when you click the map object’s question mark icon, or when you use the Explore 
command.



firewall
A type of network security that analyzes traffic and restricts access between the Internet and your
internal network. A firewall allows users to access the Internet while protecting data and 
resources on their internal networks.



frame
Extension to HTML that allows Webmasters to divide a browser’s viewing area into two or more 
windows. Each frame can be linked to a distinct URL. Commonly, frames are used to create a 
nonscrolling region of the screen, such as a company banner that stays onscreen at all times, or 
for navigation buttons that work only within the site.



FTP (File Transfer Protocol)
A protocol used for transferring files across the Internet. FTP is often used for anonymous 
downloading of text files, software, audio or video files, and other information.



full path
The directory and file name for a resource, which is the full URL without the protocol (http) and 
domain name. For example, http://www.microsoft.com/manual/index.htm is the full URL of the 
resource. The full path is /manual/index.htm.



Full URL
The complete Internet address for a resource, including the protocol and domain name. For 
example, the full URL for the Microsoft home page is http://www.microsoft.com/index.htm. The 
Full URL can be used as a label for map objects.



gateway
In a WebMap, a representation of a CGI script.



Gopher
A menu-driven, browseable index of servers, sites, directories, and file information available on 
the Internet.



heading
On an HTML page, text that has been formatted with one of several heading tags: H1, H2, H3, 
and so on. You can use the first heading encountered on HTML pages as a label for pages.



helper application
An application that can be used in conjunction with Site Analyst for browsing mapped Web sites 
or for editing map objects. For example, Internet Explorer could be a helper application for 
browsing mapped Web sites; Microsoft Word could be a helper application for editing HTML 
pages in the map; and Microsoft Image Composer could be an application for editing graphic 
images in the map.



hierarchy
The relationship between objects in the Tree view, determined by the links between the objects. 
Site Analyst creates the hierarchy by retrieving the URL for the home page, then the links on that 
page, and so on. Objects pointed to by links are shown as children of a page. 



hit count
The number of times any given page in a site is accessed by visitors. You can import details 
about hit count--and other types of usage data--into your map so that you can monitor your site’s 
effectiveness, appeal, and "extended presence" on the Web.



home page
The page from which you want to begin mapping a Web site. This could be the home page for 
the site, or any other page in the site.



HTML (Hypertext Markup Language)
A formatting language for documents (pages) on the World Wide Web. HTML files are plain text 
files with formatting codes that tell Web browsers how to display text, graphics, and hyperlinks.



HTTP (Hypertext Transfer Protocol)
The protocol used to transfer Web pages and other objects between computers and servers on 
the World Wide Web.



hyperlink
The "clickable" area on a Web page that allows you to jump from one Web object to another. 
Hyperlinks are created by the HREF attribute of the A (anchor) tag in HTML.



hyperlink text
The text string associated with a hyperlink on the parent page of an object. The hyperlink text is 
often what you click to jump to another page when you're browsing a Web page.



imagemap
A bitmapped graphic image that links to multiple URLs via hot spots on the image. You can click 
different regions of an imagemap to jump to different objects in the site. Imagemaps can be 
server-side or client-side. Server-side imagemaps map each URL on the server; they require CGI
scripts. Client-side imagemaps, on the other hand, don’t require mediating CGI scripts because 
the URL mapping is contained in an HTML file. Site Analyst recognizes client-side imagemaps 
and shows the links as children of the imagemap’s parent page.



inline
A characteristic of how an image is specified in an HTML page, which indicates that the image is 
to be downloaded and displayed in the Web page.



InLink
A link that points into a selected object from another object in the WebMap. 



Internet service
Any protocol for transferring information over the Internet, except  HTTP. The protocol is the first 
part of the full URL for an object. Internet service types include Gopher, Telnet, WAIS, NNTP, and
FTP.



Intranet
Web sites or Internet addresses inside a corporation, behind the firewall. For instance, many 
companies have an internal Web site, created and maintained by different departments in the 
company.



IP address
Internet Protocol address. A unique series of numbers that identifies a computer on the Internet. 



ISMAP
An attribute of an image tag (IMG), shown in the Properties dialog box for that image, indicating 
that the image is a server-side imagemap.



Java™
An object-oriented programming language, developed by Sun Microsystems Inc., that allows 
developers to create mini-programs (called applets) that can be embedded in Web pages and 
used across the Internet. Java programs are platform-independent, and feature real-time 
updating and interactivity—for example, stock quote "ticker tapes" that are updated every few 
minutes, interactive games, and animation.



label
In the map window, the Properties dialog box, and in results windows, the text describing an 
object or link. By default, the label for pages is the text in the TITLE tag (taken from the Name 
field on the Annotations tab of the Properties dialog box). The default for all other objects is the 
Link URL.



link
On an HTML page, the code that links the page to another object. Different HTML tags are used 
to link different types of objects. For example, the IMG tag includes images in the page, the 
FORM tag links to a CGI script, and the APPLET tag links to a Java™ applet.



Link URL
The URL associated with the link on an object’s parent page. The Link URL can be absolute (the 
full URL) or relative (the path name relative to the object’s parent page). 



Mailto
An electronic mail address, often in the form name@domainname.com.



main route
The first occurrence of a page or other object in a WebMap, displayed in black (if the object is 
onsite) or blue (if the object is offsite). The main route represents the first hyperlink to the object 
encountered by Site Analyst.



map window
The portion of the computer screen that contains the WebMap of a site. The map window is 
divided into two panes, one for the Tree view and one for the Cyberbolic view.



MIME type
The file type of an Internet resource. The MIME type has two parts: the general format of the file 
(the "major" type), and the more specific format (the "minor" type). For example, an image could 
have the MIME type image/gif or image/jpeg.



Name field
In the Properties dialog box, the place where you can enter a descriptive name for an object. You
can then choose Name as the first choice for that object type in the Labels dialog box. (For HTML
pages, the HTML TITLE text is used as the default Name.)



WebMap
A representation of the objects and links in a Web site. The WebMap is displayed in the map 
window.



NNTP (Network News Transfer Protocol)
A protocol that transfers Usenet news to Web sites on request.



Notes
In the Properties dialog box, optional annotations you can add to an object. Notes are saved with 
a published map, and are thus viewable by anyone who uses the map.



object
A page, image, audio or video file, mailto, gateway, application, or other resource in a Web site. 
All WebMap objects in Tree view are represented by icons and a text label.



offsite object
An object on a different site than its parent page. Offsite objects have blue labels in the map.



onsite object
An object that is part of the site that was originally mapped.



page
An HTML document.



parent page
In the Tree view, the page above the selected object in the map hierarchy. The parent page 
contains links that point to its "children."



PDF (Portable Document Format) file
File type developed by Adobe™ Systems, Inc. that allows users to exchange and read files 
created with different software and/or on different computer systems. You need Adobe™ 
Acrobat™ to read PDF files. 



PostScript™ file
A type of text file developed by Adobe™ Systems, Inc. PostScript files contain text and 
instructions to printers that understand the PostScript "page description" language.



Private Notes
In the Properties dialog box, optional annotations you can add to an object. Private notes are 
viewable only by you and are not saved with a published map.



Properties dialog box
Dialog box where you can view or change information about the selected map object. 



protocol
The method by which computers communicate on the Internet. The most common protocol for 
the World Wide Web is HTTP. Other Internet protocols include FTP, Gopher, and Telnet. The 
protocol is part of the full URL for an object.



proxy server
A proxy server is a program that communicates with external servers on behalf of internal clients 
by providing a single host with Internet access for multiple users. The proxy server sends 
requests back and forth between the client (on the internal network) and the external server.



proxy services
A proxy service is an application or server program that runs on a firewall host. Proxy services sit 
between a user on the inside (on the internal network) and a service on the outside (on the 
Internet). Proxy services perform complex interactions behind the scenes and give the user the 
illusion of communicating directly with the external server.



realm
For password-protected files, the name of the protected resource or area on the server. If you try 
to access the protected resource while browsing, the name of the realm usually appears in the 
dialog box that asks for your username and password.



referrer
An offsite link that is imported as usage data. These links can be found in the Link Info window as
a property of the selected page. Referrers are not themselves map objects (unless you mapped 
the referring site using the Extensions tab on the New Map dialog box); if you’re analyzing usage 
data and want to see the total number of hits, use the Link Info window rather than doing a 
search for links.



results window
A type of Site Analyst window that contains a collection of objects, which are the results of a 
search or of a map comparison. You can change the column arrangements, and you can add or 
remove properties.



robot
A fast, automated program—such as a search engine, indexing program, or cataloging software
—commonly known as a spider, that requests Web pages much faster than humans can. When 
Site Analyst automatically explores a Web site, it operates as a robot. Other commonly-used 
terms for robot include "crawler" and "spider."



robot exclusion protocol
A "code of behavior" that is generally adhered to by robots (such as Site Analyst when it 
automatically explores a site) when they attempt to access Web pages. The Robot Exclusion 
Protocol usually involves restrictions on certain parts of a site. This avoids tying up the server 
with multiple, rapid accesses. 



root directory
For a Web site, the directory on the site’s server in which the building of the map was started.



source map
In a compare and update operation, the map with customizations that you may want to preserve, 
usually the older of the two maps (source and target).



spider
A fast, automated program—such as a search engine, indexing program, or cataloging software
—that requests Web pages much faster than humans can. When Site Analyst automatically 
explores a Web site, it operates as a spider. Another commonly-used term for spider is "crawler."



target map
In a compare and update operation, the map that you may want to update with the source map’s 
customizations, usually the newer of the two maps (source and target).



Telnet
Internet protocol that allows a user to log in to a remote computer, using a public or private 
account.



TITLE
On an HTML page, a text string at the top of the page that usually gives a descriptive name for 
the page. For map pages, the Title text is used by default as the Name field. 



Tree view
The "pane" on the left side of the Microsoft Site Analyst map window. This view shows the site as 
a linear hierarchy (much like Explorer in Windows 95 or NT 4.0 or File Manager in Windows NT 
3.x).



unexplored object
An object whose URL has not yet been retrieved by Site Analyst. An object gets explored when 
you click its question mark icon (in Tree view), or when you use the Explore command.



unavailable object
A page or other object that Site Analyst cannot retrieve, because the URL is not valid, the object 
doesn’t exist, or the server containing the object is busy or having other technical difficulties.



URL (Uniform Resource Locator)
The Internet address for an object. A URL can be absolute (the full URL) or relative (the path 
name relative to the parent page’s URL).



usage data
Information you can import into your map to tell you how other people are accessing and using 
your site. Analyzing this data helps you identify your site’s most popular (or unpopular) areas, 
clarifies the most common navigational paths through your site, and helps you monitor the site’s 
"extended presence" on the Web.



USEMAP
An attribute of an image (shown in the Properties dialog for that image), indicating that the image 
is a client-side imagemap.



Usenet news
News articles and information shared by Internet users. Usenet URLs are in the form 
news:name_of_newsgroup or news:message-id.



verify
To check that a page exists at the specified URL. Unlike exploring, verifying does not look up the 
URLs for any links to resources that may exist on that page. Site Analyst verifies resources as 
the first step in the exploration process, or when you use the Mapping|Verify Links command.



WAIS (Wide Area Information Server)
A method for searching and retrieving information from databases available on the Internet.



wmp file
The file name extension of a saved WebMap.



Webmaster

The person who manages a Web site. 



Menu Commands

Chose from the following list for information on a menu command:

File menu
View menu
Mapping menu
Tools menu
Window menu
Help menu
Right-click menu in Tree view
Right-click menu in Cyberbolic view



File menu commands

The File menu offers the following commands:

Command Description

 New|Map from URL Creates a new WebMap from a URL.
 New|Map from File Creates a new WebMap from a local or networked filesystem.
 Open Displays the Open dialog box, where you can specify a file 

name to open an existing map file.
Close Closes an opened map file.

 Save Saves an opened map using the same map file name.
Save As Saves an opened map file to a specified file name.
Publish Displays the Publish dialog box, where you can publish maps 

that you’ve created.
Import Usage Data Imports Web-site usage data (data about hit counts, for 

example).
Export|Tree View Exports the Tree view to HTML or tabbed text.
Export|Results Exports the search or compare and update results to HTML or 

tab-delimited text.
Export|Link Info Exports the Link info window to HTML or tab-delimited text.
Print|Tree View Prints the Tree view.
Print|Cyberbolic View Prints the Cyberbolic view.
Print|Results Prints the search or compare and update results.
Print Preview|Tree view Displays the Tree view as it will look when printed.
Print Preview|Cyberbolic view Displays the Cyberbolic view as it will look when printed.
Print Preview|Search Results Displays the search or the compare and update results as they 

will look when printed.
<list of files> A dynamic list of the last four files you have opened.
Exit Exits the Microsoft Site Analyst program.



View menu commands

The View menu offers the following commands:

Command Description

 Object Properties 
Displays the Properties dialog box, where you can view and change 
information about the objects in the site.

 Object Links Displays the Link Info window, where you can view information about
links on a page, InLinks, and main routes of the selected object. You 
can arrange the columns in any order you like.

 Site Statistics Displays the Statistics dialog box, where you can view statistics 
about the site. The Object Count tab lists the number of pages, links,
and other resources.

Expand Branch Expands the Tree view to the level of your choice.
Hide Object Hides the selected object in the Tree view. Shortcut: Ctrl+H.
Column|Results 
Columns

Displays the Results Column dialog box, where you can specify the 
properties to display in the Search Results window. You can arrange 
the columns in any order you like.

Columns|Links Columns Displays the Configure Columns dialog box for the Link Info window, 
where you can specify the properties to diplay in the Link Info 
window. You can arrange the columns in any order you like.

Quick Columns Displays the default and custom column arrangements.
Toolbars|Main Shows or hides the Main toolbar. In the submenu, a checkmark next 

to Main indicates the Main toolbar is displayed.
Toolbars|Cyberbolic Shows or hides the Cyberbolic toolbar. In the submenu, a checkmark

next to Cyberbolic indicates the Cyberbolic toolbar is displayed.
Status Bar Shows or hides the status bar at the bottom of the map window. As 

you move the mouse pointer over menu commands or toolbar 
buttons, brief descriptions of those items appear in the status bar. A 
checkmark next to the Status Bar menu item indicates the Status 
Bar information is displayed.

 Display Options Displays the Display Options dialog box, where you can view and 
change how objects are displayed in both views.

 Label Options Displays the Labels dialog box, where you can view and change how
objects are labeled.

Program Options Displays the Program Options dialog box, where you can view and 
change program options.



Mapping menu commands

The Mapping menu offers the following commands:

Command Description

 Explore|Site Displays the Explore dialog box, where you can set exploration limits 
and mapping options (such as verifying offsite links and honoring robot 
protocol) before sending the spider to explore more of the site.

 Explore|Branch Displays the Explore dialog box, where you can set exploration limits 
and mapping options (such as verifying offsite links and honoring robot 
protocol) before sending the spider to explore more of the branch.

Remap Site Displays the Remap Site dialog box, where you can set explore, update, 
and reporting options before you remap a site.

 Verify Links 
Displays the Verify Links dialog box, where you can verify onsite or 
offsite links. For each of these, you can verify all links or only the broken 
links.

Set Routes Sets the routes by URL hierarchy or usage data.
Go to Main Route Selects the associated main route of the selected alternate route.
Make Main Route Makes the selected alternate route become the main route.
Mapping Options Displays the Mapping Options dialog box, where you can view and 

change a variety of options. For example, you can add mapping 
extensions or restrictions.



Tools menu commands

The Tools menu offers the following commands:

Command Description

Quick Search|<search names> Lists the predefined and custom quick searches. 
Custom Search Displays the Search dialog box, where you can search for 

objects with specific fields, and specify advanced search 
criteria (such as And and Or searches).

Generate Site Reports Displays the Generate Site Reports dialog box, where you 
can generate and save reports in HTML format.

 Compare and Update Displays the Compare and Update dialog box, where you can
compare two maps or update one map from another.

Launch Browser Launches your default Web browser to display the page or 
other object you selected in the map.

Launch Helper App Lists the helper applications (available for the specified object
type) and then launches the one you choose.



Window menu commands

The Window menu offers the following commands:

Command Description

Cascade Arranges the map windows so they overlap. The contents of the 
window on top are visible, but you can only see the title bars of the
other windows.

Tile Arranges the map windows in side-by-side “tiles.” The contents of 
each window are visible.

Arrange Icons Arranges the icons of closed windows.
Close All Closes all open map windows.
<open windows> Shows a list of all open map windows. A checkmark indicates the 

most recently opened map window.



Help menu commands

The Help menu offers the following commands:

Command Description

Help topics Displays the Site Analyst Help dialog box, which contains the 
Contents tab, Index tab, and Find tab. All three tabs allow you to 
search for topics in the Help system.

Help Contents Displays the custom Site Analyst Help contents screen. From here, 
you can jump to a variety of topics, including descriptions of the user 
interface, instructions for performing common tasks, keyboard 
shortcuts, menu commands, and the glossary.

Using Help Provides general instructions on how to use the Microsoft Windows 
95 Help system, including using hypertext links and glossary popup 
text.

User’s Guide Opens the online Site Analyst User’s Guide in your Web browser. The
User’s Guide has hypertext links for navigation, and can be printed 
from your Web browser.

User’s Guide Index Opens the index to the online Site Analyst User’s Guide.
Tutorial Opens the Site Analyst tutorial in your Web browser.
About Site Analyst Displays version, copyright, and licensing information about Site 

Analyst.



Right-click menu in Tree view

When you click the right mouse button on an object or link icon in Tree view, a menu with the 
following commands appears:

Command Description

Launch Browser Launches your default Web browser to display the page or other object 
you selected in the map.

Launch Helper 
Application

Lists the helper applications available for the specified object type and 
then launches the one you choose.

Hide Object Hides the selected object. Shortcut: Ctrl+H.

Explore Branch Displays the Explore dialog box, where you can set exploration limits 
and mapping options (such as verify offsite links and honor robot 
protocol) before sending the spider to explore more of the branch.

Expand Branch Expands the map from the selected object to the level of your choice.

Go to Main Route Selects the associated main route of the selected alternate route.

Make Main Route Makes the selected alternate route become the main route.

Links Displays the Link window, where you can view information about links on
a page, InLinks, and main routes of the selected object. You can arrange
the columns in any order you like.

 Properties
Displays the Properties dialog box, where you can view and change 
information about the objects or links in the site.



Right-click menu in Cyberbolic view

When you click the right mouse button on an object in Cyberbolic view, a menu with the following 
commands appears:

Command Description

Launch Browser Launches your default Web browser to display the page or other object 
you selected in the map.

Launch Helper 
Application

Lists the helper applications available for the specified object type and 
then launches the one you choose.

Hide Object Hides the selected object. Shortcut: Ctrl+H.

Explore Page Explores an unexplored page and displays the children in both Tree and 
Cyberbolic views.

Explore Branch Displays the Explore dialog box, where you can set exploration limits 
and mapping options (such as verify offsite links and honor robot 
protocol) before sending the spider to explore more of the branch.

Go to Main Route Selects the associated main route of the selected object.

Make Main Route Makes the selected alternate route become the main route.

Links Displays the Link window, where you can view information about links on
a page, InLinks, and main routes of the selected object. You can arrange
the columns in any order you like.

 Properties Displays the Properties dialog box, where you can view and change 
information about the objects or links in the site.



Keyboard Shortcuts

Site Analyst provides keyboard shortcuts for actions that otherwise require you to use the mouse.
Where these keystrokes are equivalent to a menu command, they appear in the menu following 
the command name. In many cases there are three ways to access a menu command. For 
example, to display the Open File dialog box, you can do any of the following:

· Choose File|Open with the mouse.
· Press Alt+F to display the menu, and then press O to execute the command.
· Press Ctrl+O (the keyboard shortcut).

The following table lists the keystrokes that are in effect at all times.

Menu command Keystrok
e

Description

Ctrl+N Opens the New Map dialog box, where you can 
check URL or Map.

File|Open Ctrl+O Opens the File dialog box, where you can enter a 
map file name, or choose from an existing list of 
map files.

File|Save Ctrl+S Saves the current file.

WebMap|Explore Ctrl+X Opens the Explore dialog box,where you can limit 
pages and levels to explore and verify links to other
sites.

Ctrl+H Hides all routes to the selected object, whether or 
not you have the Properties dialog box displayed 
on your screen.

Alt+R Hides all routes to the selected object when the 
Properties dialog box is active.

Alt+L Hides all alternate routes to the selected when the 
Properties dialog box is active.





Dialog Boxes

Choose a topic for a description of that Site Analyst dialog box or window:

Add (Passwords) Mapping Options 

Add Helper Application New Map from File 

Add Proxy Bypass New Map from URL 

Compare and Update Node Distance 

Configure Columns for the Links Display Program Options 

Display Options Properties 

Explore Publish 

Generate Site Reports Quick Search descriptions 

Import Usage Data Remap Site 

Labels Result Columns 

Link Info window Search 

Link Properties (Link Info window) Set Routes 

Site Statistics 

Verify Links 





Displays the New Map From URL dialog box, where you can create a new map from a URL.



Displays the New Map From File dialog box, where you can create a new map from a file name on a 
local or networked filesystem.



Displays the Open dialog box, where you can specify a file name to open an existing map file.



Closes an opened map file.



Saves an opened map using the same map file name.



Saves an opened map file to a specified file name.



Displays the Publish dialog box, where you can publish maps that you’ve created.



Displays the Import Usage Data dialog box, where you can import a file that contains information about
hit counts.



Displays the Export Tree View dialog box, where you can export the Tree view to a file name in HTML 
or tabbed text.



Displays the Export Search Results dialog box, where you can export the search results to a file name 
in HTML or tabbed text.



Displays the Export Links dialog box, where you can export link information to a file name in HTML or 
tabbed text.



Prints the Tree view.



Prints the Cyberbolic view.



Prints the search or compare and update results.



Displays the Tree view as it will look when printed.



Displays the Cyberbolic view as it will look when printed.



Displays the search or compare and update results as they will look when printed.



A dynamic list of the last four map files that have been opened.



Exits the Microsoft Site Analyst program.



Displays the Object Properties dialog box, where you can view and change information about the 
objects and links in the site.



Displays the Link Info window, where you can view information about links on a page, InLinks, and 
main routes of the selected object. You can arrange the column properties in any order you like.



Displays the Statistics dialog box, where you can view statistics about the site. The Object Count tab 
lists the number of pages, links, and other resources.



Expands the Tree view one level.



Expands the Tree view two levels.



Expands the Tree view three levels.



Expands the Tree view to all levels.



Hides the selected object in the Tree view. Shortcut: Ctrl+H.



Displays the Results Columns dialog box, where you can specify which properties to display in the 
Search Results window. You can arrange the columns in any order you like.



Displays the Configure Columns for Links dialog box, where you can specify which properties to 
display in the Link Info window. You can arrange the columns in any order you like.



Displays the default and custom column arrangements for each listed object type.



Shows or hides the Main toolbar. In the submenu, a checkmark next to Main indicates the Main toolbar 
is displayed.



Shows or hides the Cyberbolic toolbar. In the submenu, a checkmark next to Cyberbolic indicates the 
Cyberbolic toolbar is displayed.



Shows or hides the status bar at the bottom of the map window. As you move the mouse pointer over 
menu commands or toolbar buttons, brief descriptions of those items appear in the status bar. A 
checkmark next to the Status Bar menu item indicates the Status Bar information is displayed.



Displays the Display Options dialog box, where you can enter and change how objects are displayed in
both Tree and Cyberbolic views.



Displays the Labels dialog box, where you can view and change how objects are labeled in both Tree 
and Cyberbolic views.



Displays the Program Options dialog box, where you can view and change program options.



Displays the Explore dialog box, where you can set exploration limits and mapping options (such as 
verifying offsite links and honoring robot protocol) before sending the spider to explore more of the site.



Displays the Explore dialog box, where you can set exploration limits and mapping options (such as 
verifying offsite links and honoring robot protocol) before sending the spider to explore more of the 
branch.



Displays the Remap dialog box, where you can create a new map of the same site using the available 
options in this dialog box.



Displays the Verify Links dialog box, where you can verify onsite or offsite links. For each of these, you 
can verify all links or only the broken links.



Displays the Set Routes dialog box, where you can set the routes by URL hierarchy or usage data (hit 
counts).



Selects the associated main route of the selected alternate route.



Makes the selected alternate route become the main route.



Displays the Mapping Options dialog box, where you can view and change a variety of options. For 
example, you can add extensions or restrictions for a site.



Displays a list of Quick Searches, which are predefined searches that ship with Site Analyst. Also, 
when you customize and save your own searches, those names will appear on this submenu (Site 
Analyst Professional version only). For a description of the Site Analyst predefined searches, see the 
Help contents and click the Dialog boxes topic.



Displays the Search dialog box, where you can search for objects with specific fields, and specify 
advanced search criteria (such as And and Or searches).



Displays the Generate Site Reports dialog box, where you can generate and save reports in HTML 
format.



Displays the Compare and Update dialog box, where you can compare two maps or update one map 
from another.



Launches your default Web browser to display the page or other object you selected in the map.



Launches the first helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Launches the second helper application you configured in the Add Helper Application dialog box on the
Helpers tab of the Program Options dialog box.



Launches the third helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Launches the fourth helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Launches the fifth helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Launches the sixth helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Launches the seventh helper application you configured in the Add Helper Application dialog box on 
the Helpers tab of the Program Options dialog box.



Launches the eighth helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Launches the ninth helper application you configured in the Add Helper Application dialog box on the 
Helpers tab of the Program Options dialog box.



Arranges the map windows so they overlap. The contents of the window on top are visible, but you can
only see the title bars of the other windows.



Arranges the windows in a vertically-tiled manner.



Automatically arranges the icons to a pre-set position.



Closes all open map files.



A dynamic list of all open windows.



Displays the Site Analyst Help dialog box. This dialog box contains the Contents tab, Index tab, and 
Find tab. All three tabs allow you to search for topics in the Help system.



Displays the Site Analyst custom Help contents screen. From here, you can jump to a variety of topics, 
including descriptions of dialog boxes, instructions for performing common tasks, keyboard shortcuts, 
menu commands, the glossary, and how to contact technical support.



Displays the Microsoft Windows Help topics, and describes how to use Windows 95 Help.



Launches your browser and opens the online User's Guide, an HTML document that you can 
view and print.



Launches your browser and opens the online User's Guide Index. The index is an HTML document, in 
which you can navigate to specific topics and then click a topic to jump to that page in the online User’s
Guide.



Launches your browser and opens the Tutorial. It is suggested that you work from a printed copy of the
Tutorial so as not to tie up your browser.



Displays a window that contains version and licensing information about Microsoft Site Analyst.



Welcome to Microsoft Site Analyst

The Microsoft Site Analyst™ Welcome screen is your entry into the Microsoft Site Analyst 
product. Just click any of the four buttons and be on your way to Web site mapping and 
management with Microsoft Site Analyst!

You can also view the online User’s Guide! Just click the View User’s Guide button, and the 
online manual will open in your browser. 



 No Map Window Selected

You pressed F1 without having a map open in the map window. You need to open a map in the 

map window, and then you can access Help on any menu item or dialog box. Click  on the 
Toolbar to open a map.

The Microsoft Site Analyst™ windows can be controlled and manipulated like any other window 
in the Microsoft Windows™ environment. The map window contains the map, and the other Site 
Analyst windows contain a search results window, a comparison results window, or the Link Info 
window.

You can minimize the window so that it appears as an icon, and you can double-click to reopen it.
You can also move and resize the window, or open multiple map windows to show different 
maps.



New Map from URL dialog box

Use this dialog box to create a new map from a URL    address. 

To access this dialog box:

· Choose New from the File menu, then choose Map From URL.

· Click  on the toolbar. The New Map dialog box appears, where you can enter a URL.

Field Description

Home Page Address 
(URL)

Enter the URL of the Web site you want to map. For example, www.Microsoft.com. 

Options… Click this button to access the Mapping Options dialog box . This dialog box lets you 
view and change a variety of options, including verifying offsite links and honoring 
robot protocol. Click OK to save your changes and revert to the New Map from URL 
dialog box, or click Cancel.

Explore Entire Site When checked, Site Analyst looks up URLs for the whole site, starting from the top 
down, beginning at the home page.
Warning: If this is checked, be aware that Site Analyst will also explore all the sites 
you’ve specified on the Extensions tab of the Mapping Options dialog box. This 
includes public Web sites that you have links to in your site.

Set Routes by URL 
Hierarchy

When checked, pages appear as main-route objects in the map according to their 
relative positions in the site root path. This organizes your map according to the way 
your site is structured, not according to the order links are discovered on pages.

Generate Site Reports When checked, Site Analyst generates site reports automatically. The reports are 
stored in a location you specify. When Site Analyst has finished mapping and 
analyzing your site, the Summary Report appears in your browser.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 
All About Routes (User’s Guide) 



New Map from File dialog box

Use this dialog box to create a new map from a file (on a local or networked filesystem).

To access this dialog box:

· Choose New from the File menu, then choose Map From File.

· Click  on the toolbar. The New Map From dialog box appears in which you can enter a 
path and file name.

Field Description

Home Page Path and 
File Name

Enter the home page path and file name. For example, C:\MYSITE\index.htm. 

Options… Click this button to access the Mapping from File Options dialog box. This dialog box 
lets you view and change a variety of options, including verifying offsite links and 
honoring robot protocol. Click OK to save your changes and revert to the New Map 
from File dialog box, or click Cancel.

Domain and Site Root Enter the domain and site root directory. If you want to start mapping the site from a 
page other than the site’s top home page, add the site root path to the page where 
you want to start after the domain name. 

CGI Bin Directory Specify the location of your CGI bin directory. If your site includes any links to CGI 
program scripts, and the CGI bin directory is not located at \cgi-bin, you need to tell 
Site Analyst where the scripts are located.

Explore Entire Site When checked, Site Analyst looks up URLs for the whole site, starting from the top 
down, beginning at the home page. (Site Analyst Standard Edition explores up to 150 
pages.)

Set Routes by URL 
Hierarchy

When checked, pages appear as main-route objects in the map according to their 
relative positions in the site root path. This organizes your map according to the way 
your site is structured, not according to the order links are discovered on pages.

Generate Site Reports When checked, Site Analyst generates site reports automatically. The reports are 
stored in a location you specify. When Site Analyst has finished mapping and 
analyzing your site, the Summary report appears in the your browser.

RELATED TOPICS
Mapping Options dialog box 
Working with HTML Reports (User’s Guide) 
Help on HTML Reports 
Creating and Customizing WebMaps (User’s Guide) 
All About Routes (User’s Guide) 



New Map dialog box

Use this dialog box to create a new map from a URL or from a file (on a local or networked 
filesystem).
To access this dialog box:

· Click  on the toolbar.
· Press Ctrl+N

Field Description

URL Displays the Map from URL dialog box, where you can create a map from a specified 
URL.

File Displays the Map from File dialog box, where you can create a map from a local or 
networked filesystem.

RELATED TOPICS
New Map from URL dialog box 
New Map from File dialog box 



Open dialog box

Use this dialog box to open an existing map.

To access:

· Choose Open from the File menu.

· Click  on the toolbar.

Field Description

Look in Select the directory from which you want to open a map file.
File name Enter the name of the map file you want to open, or double-click a file name from 

the list of names.
Files of 
type

Choose from a list of the types of available files.

Save As dialog box

Use this dialog box to save a WebMap.

To access:

· Choose Save As from the File menu.

· Click  if this is the first time you’re saving a map.

Field Description

Save in Select the directory in which you want to save a map file.
File name Enter the map file name that you want to save, or double-click an existing file name.
Files of 
type

Choose from a list of the types of files available to you.

Incorrect Help Selection

Incorrect Help access!
One of three situations has occurred:

· You pressed F1 on a menu item that has an associated “pull-right” submenu item.
· You pressed F1 on a toolbar button.
· You pressed F1 while your cursor was placed on the map window background in Cyberbolic 

view, or without having an object selected in Tree view.

To get Help on a menu item that has a “pull-right” submenu item:

· Highlight both the menu item and its submenu item, and then press F1 on the submenu item.
A help description appears.



To get Help on the functionality of the toolbar buttons:

· Pass your cursor over each button and view the pop-up button label, as well as the 
description in the status bar at the bottom of the map window.

· Click  on the toolbar and choose Toolbar from the Contents screen.
· Choose Contents from the Help menu and choose Toolbar from the Contents screen.

For information on the map window, see Anatomy of a WebMap (User’s Guide)



Explore dialog box

Use this dialog box to further explore the map or to narrow the scope of exploration. The Explore 
dialog box looks up URLs that you have links to in the site. The Explore dialog box appears 
automatically when you create a new map if you uncheck the Explore Entire Site checkbox on 
the New Map from URL dialog box .

To access this dialog box:

· Choose Explore|Site or Explore|Branch from the Mapping menu.

· Click  on the toolbar.
· Shortcut: Ctrl+E

Field Description

Page Limit Limits the number of pages that will be explored in the map. The default is 100 pages if 
you mapped from a URL, and 1000 pages if you mapped from a file.

Limit Levels to: Limits the number of levels that will be explored in the map. You can enter any number, 
but limiting to 2 or 3 levels is the most efficient.

Set Routes by URL 
Hierarchy

When checked, pages appear as main-route objects in the map according to their 
relative positions in the site root path. This organizes your map according to the way 
your site is structured, not according to the order the links are discovered on pages.

Options… Click this button to access the Mapping Options dialog box. This dialog box lets you view
and change a variety of options, including verifying offsite links and honoring robot 
protocol. Click OK to save your changes and revert to the New Map dialog box, or click 
Cancel.

RELATED TOPICS
Mapping Options dialog box 
All About Routes (User’s Guide) 



Publish dialog box

Use this dialog box to customize publish options for publishing a map.

To access this dialog box:

· Choose Publish from the File menu.

Field Description

Publish As Enter the path and file name for the map you want to publish, or use the Browse 
button. The wmp extension is appended automatically to the file name.

Publish All Objects Select this option to include all object types. All the object choices are disabled; you 
cannot individually clear any objects. Only main-route objects are included unless you
select Publish Alternate Routes at the bottom of the dialog box.

Publish Only When you clear Publish All Objects, this field becomes active. You can select object 
types individually to publish. By default, the settings in this list match the map’s 
current display options. Only main-route objects are included unless you select 
Publish Alternate Routes. “Pages” are not included in this list because they’re always 
published with a map.

Select All Click this button to select all the object types. You can then clear one or more objects 
if you want to.

Clear All Click this button to clear all the object types.
Publish Alternate 
Routes

Select this option to include alternate routes with the selected object types.

Load Default Loads the publish settings. By default, these settings are the same as the default 
Display Options settings. But you can change these settings by saving your own 
customized settings as the default. If you do, you will overwrite the original publish
settings.

Save As Default Saves your customized settings as the default publish settings. A warning message 
appears asking if you want to overwrite the current default settings. If you do overwrite
them, your new settings will appear every time you click Load Default.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Tree tab (Display Options)

Use this dialog box to show or hide objects in Tree view, and to show alternate routes as link 
icons or object icons.

To access this dialog box:

· Choose Display Options from the View menu.

· Click  on the toolbar.

Field Description

Show All Objects Shows all objects in Tree view. When you select this checkbox, all listed objects are 
disabled, indicating they will all be shown in Tree view.

Show Only When you clear Show All Objects, this field becomes active. You can then choose which
objects you want to display in Tree view.

Select All Selects all the objects. You can then clear one or two objects.
Clear All Clears all the objects.
Show Alternate 
Routes

Shows alternate routes to objects. By default, this box is not checked. If you select this 
option, alternate routes are displayed in Tree view, and the boxes below this option 
become active. 

Within Page Shows alternate routes that are on the same page.
Allow Expansion Allows alternate routes to be expanded.
Display As Displays alternate routes as either link icons (the default) or object icons.
Load Default Loads the default display options. If you’ve changed the display options, you can click 

Load Default and the original default settings automatically return to the dialog box. 
However, if you’ve saved any changes by clicking the Save As Default button, those 
changes are now the default display options and will appear in the dialog box each time
you click Load Default. 

Save As Default Saves the current display options as the default. Note: If you change the default 
settings and save them, you overwrite the settings that come with Site Analyst. To 
return to the original default settings, you must set them manually and click Save As 
Default.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Cyberbolic tab (Display Options)

Use this dialog box to show or hide objects in Cyberbolic view, show alternate routes, and 
change some Cyberbolic settings.

To access this dialog box:

· Choose Display Options from the View menu.

· Click  on the toolbar.

Field Description

Show All Objects Shows all objects in Cyberbolic view. When you select this checkbox, all listed objects 
are disabled, indicating they will all be shown in Cyberbolic view.

Show Only When you clear Show All Objects, this field becomes active. You can then choose which
objects you want to display in Cyberbolic view.

Select All Selects all the objects. You can then clear one or two objects if you want to.
Clear All Clears all the objects.
Show Alternate 
Routes

Shows alternate routes to objects. By default, this box is checked. If you clear this 
option, alternate routes are not displayed in the map, and the boxes below this option 
are disabled. 

Show Icons For each object (except pages), displays an icon that identifies its object type.
Font Size From the list, choose small, medium, or large font size for the Cyberbolic labels.
Orientation Lets you determine how you want the map to be displayed—with the home page at the 

left side of the Cyberbolic pane with the other pages fanning out to the right (the 
default), or with the home page at the center with the other pages fanning out all around
it.

Node Distance Lets you specify how far apart you want to display the map objects (called “nodes” in 
the Cyberbolic view). Slide the indicator between Near and Far to see which distance 
you prefer.

Load Default Loads the default display options. If you have changed the display options, you can 
click Load Default and the original default settings automatically return to the dialog 
box. However, if you have saved any changes by clicking the Save As Default button, 
those changes are now the default display options and will appear in the dialog box 
each time you click Load Default. 

Save As Default Saves the current display options as the default. Note: If you change the default 
settings and save them, you overwrite the settings that come with Site Analyst. To 
return to the original default settings, you must set them manually and click Save As 
Default.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 
Changing the label font size in Cyberbolic view 
Changing the orientation in Cyberbolic view 
Changing the node distance in Cyberbolic view 



Search dialog box

Use this dialog box to set up specific search criteria to search for particular objects and links.

To access this dialog box:

· Choose Search from the Tools menu.

· Click  on the toolbar.
· Shortcut: Ctrl+F

Field Description

Search Specifies which part of the map you want to search.
Search Type Lists the types of searches you can perform. 
Object Type Lists the objects you can search for in the map. You can also search for links.
Field Lists the fields you can search for in the map. The available field options are determined by 

what you choose in the Object Type list.
Modifiers Specifies which search modifier you want to apply. The Field option determines which 

modifiers are available.
Not Objects or links that don’t match certain criteria. For example, you might want to find all 

pages that don’t have the words “Special Offer” in their titles.
Text 
String/Value 

Specifies a text string if you’re performing a text search, a numeric value if you’re 
performing a numeric or date value search, or TRUE or FALSE.

Match case When checked, searches for the text string using the exact capitalization you type.
Advanced 
button

Expands the Search dialog box to include additional search criteria. You can choose And 
and Or searches and then specify the additional search criteria in the list boxes. Click Basic 
to return to the simple search criteria.

RELATED TOPICS
Using Quick Searches 
Searching Maps and Creating Custom Reports (User’s Guide 



Search List (Search dialog box)

Use the Search list to specify which part of the map you want to search.

Search Options Description

Entire Map (default) Searches the entire map, regardless of what is currently displayed.
Current Tree View Searches only those parts of the Tree view that are currently displayed.
Current Results Searches the objects contained in the active results window (search or map 

comparison results).

RELATED TOPICS
Search dialog box 
Searching Maps and Creating Custom Reports (User’s Guide 



Search Type List (Search dialog box)

Use the Search Type list to specify the types of searches you want to perform. When you select a
predefined quick search, notice that the dialog box fields become inactive. Just click the Search 
button. Site Analyst searches the entire map and displays the Search Results window.

Search Type Description

<Custom Search> The standard search criteria. You can change any of the fields in the Search dialog
box to search for objects or links with a variety of search criteria. 

Hidden Objects
(quick search)

Searches for pages and other resources that are currently hidden, either 
individually (via the View|Hide Object command) or by object type (with the View|
Display Options dialog box).

Home Site Objects
(quick search)

Searches for pages and other resources on the same domain as the site’s home 
page.

Images Without ALT
(quick search)

Searches for images that don’t have the optional ALT attribute text string.

Load Size Over 32K
(quick search)

Searches for pages whose load size (the size of the HTML page plus any linked 
inline resources, such as images) is larger than 32K.

Non-Home Site Objects
(quick search)

Searches for pages and other resources on a different domain than the site’s home
page.

Not Found Objects (404)
(quick search)

Searches for pages and other resources that didn’t exist on the server when Site 
Analyst mapped the site.

Objects with Referrals
(quick search)

Searches for pages and other resources that contain offsite InLinks imported as 
usage data.

Unavailable Objects
(quick search)

Searches for pages and other resources that couldn’t be reached when Site 
Analyst mapped the site. For a list of common HTTP error codes, see “Managing 
Links” in the User’s Guide.

Unverified Objects
(quick search)

Searches for pages and other resources for which one or more links have been 
found, but which have not been verified as accessible.

<user-defined search> A customized search that you’ve created, named, and saved. Set up the Search 
dialog box criteria, and click Save. In the Search Name field, enter any name you 
want. Your new Quick search will appear in the Search Type list.

RELATED TOPICS
Search dialog box 
Using Quick Searches 
Creating and Customizing WebMaps (User’s Guide) 
Site Management Tips and Techniques (User’s Guide) 
Managing Links (User’s Guide) 



Object Type list (Search dialog box)

Use the Object Type list to specify whether you want to search for all objects that match the 
criteria or for a particular object type that matches the criterion. You can also choose to search for
links.

Object type Description

All Objects All of the items in the list except links.
Gateways A server-executed program associated with an HTML form.
Images All images in the map.
Internet Services All services, such as Mailto, FTP, Gopher, etc. (except HTTP).
Links Links, such as the HREF in the HTML ANCHOR tag, the SRC in the IMG tag, and so 

on. Links encompass both main routes and alternate routes.
Other Audio and video files, PostScript and Java files, WebMaps, and so on. Unrecognized 

object types are also included.
Pages (default) HTML pages.

RELATED TOPICS
Search dialog box 



Field list (Search dialog box)

Use the Field list to specify what map field you want Site Analyst to search in.

The available fields are determined by what you choose in the Object Type list. Many of these 
items correspond to the label options in the Labels dialog box. The default field is <all objects of 
type>.

To see what is available in the Field list, which is dependent upon the choice in the Object 
Type list, see the User’s Guide:

Searching Maps and Creating Custom Reports (User’s Guide) 

RELATED TOPICS
Search dialog box 



Modifiers list (Search dialog box)

The field option you choose determines which modifiers are available. 

Field Type Search Modifier Description

Text Contains The string is anywhere in the text field.
Ends with The string is at the end of the text field.
Matches Exactly The string is the entire text field.
Starts with The string is at the beginning of the text field.

Image attribute 
usage

Is The field is the specified value (in the Value box).

Is Not The field is not the specified value (in the Value box).

Numeric Equals The field is equal to the specified value (in the Value box).
Not Equal To The field is not equal to the specified value.
Greater Than The field is greater than the specified value.
Greater Than or 
Equal To

The field is greater than or equal to the specified value.

Less Than The field is less than the specified value.
Less Than or 
Equal To

The field is less than or equal to the specified value.

Boolean Equals The field is equal to the specified value of TRUE or FALSE.

RELATED TOPICS
Search dialog box 



Text String/Value box (Search dialog box)

Use the Text String/Value box to do any of the following:

· Specify a text string if you’re performing a text search.
· Specify a numeric value if you’re performing a numeric search.
· Specify Absent, Consistent, or Inconsistent if you’re performing a Usage search.
· Choose True or False if you’re performing a Boolean search.

Note: You can type %domain instead of typing the domain name of the home site you mapped 
from. For example, if the home site domain is www.microsoft.com, Site Analyst understands that 
%domain is a substitute for the home site domain name, www.microsoft.com.

RELATED TOPICS
Search dialog box 



Search Results window

The Search Results window shows the properties of objects and links that you’ve searched for. 
For a detailed list of available properties, see the User’s Guide.

To change the column configuration using the quick columns:

1. Right-click any of the column headings (for example, MIME Type). Click Quick 
Columns and choose one of the quick column default configurations.

2. The label headings will automatically change to the default setting for that 
particular quick column. 

Note: The column configuration that is currently active is also shown in the Results
Column dialog box in the Quick Columns section.

To change the column configuration using the Results Column dialog box:

1. Right-click any of the column headings (for example, Label). Click Columns.
2. The Results Columns dialog box appears, where you can change the column 

configurations by adding or removing properties, or by changing the quick column 
settings.

RELATED TOPICS
Results Columns dialog box 
Searching Maps and Creating Custom Reports (User’s Guide) 



Results Columns dialog box

Use this dialog box to add or delete properties (columns) in the Search Results window, and to 
arrange the properties columns in an order to your liking.

To access this dialog box:

· Perform either a Quick Search or a Customized Search, so that the Search Results window 
appears.

· From the View menu, click Results Columns.

Field Description

Quick Columns Lists each search object type, and its set of default properties column arrangements (in 
the Show These Properties area). As soon as you add or delete properties in a column 
arrangement, that arrangement becomes the default. If you want to keep the Site 
Analyst default settings, you can create your own column arrangement and give it a 
different name. The new name and arrangement will automatically appear in Quick 
Columns and Show These Properties.

New Click this button to add a new column arrangement name.
Delete Click this button to delete the currently visible Quick Columns object type. A warning 

message will appear asking, for example, “Are you sure you want to delete PAGES?”
Available Properties Lists the column arrangement properties. You can add one property at a time with the 

Add button, or add all the properties by clicking the Add All button. Likewise, you can 
remove one property or all the properties.

Show These 
Properties

Lists the properties (column arrangements) for the object type listed in the Quick 
Columns list. You can move properties up or down to find the order you like for the 
column arrangement.

Show Types When checked, adds the abbreviation of the object type to each property. For example, 
A is All Objects. Any property that applies to all objects will appear with the letter A in 
front of its name.

Done Click Done when you are satisfied with your column arrangements. In the active results 
window, the properties columns appear (from left to right) in the order that you arranged
them (from top to bottom) in the Show These Properties list.

RELATED TOPICS
Search Results window 
Searching Maps and Creating Custom Reports (User’s Guide) 



New dialog box (Column Arrangement)

Use this dialog box to add a new column arrangement name (property). You can add any name 
you like. You can then customize this column name by adding or removing any property you 
want.

Note: The column setting that was active in the Quick Column section (for example, Images) will 
be the column setting when you create a new column name. You can keep this default setting for 
your new column name or customize it.

To access this dialog box:

1. From the Results Columns dialog box click the New button.

2. Type in a name you want of any length. The name will appear in alphabetical order
in the Quick Column section of the Results Column dialog box.

RELATED TOPICS
Results Column dialog box 



Link Info window

Use this dialog box to see a list of links associated with the selected object. You can change the 
size of the columns by clicking and dragging the column boundaries. You can also change the 
default column arrangement properties.

To access this dialog box:

· Choose View|Object Links
· Right-click an object and choose Links.

· Click  on the toolbar.

Field Description

Links on Page (default) For pages only, shows all links on the selected page.
InLinks Shows all links from other pages that point to the selected object. These InLinks may

be from pages in the same site, or from another site (if you’ve imported usage data 
or explored other sites in addition to the “home” site).

Main Route Shows all ancestor links on the main route of the selected object. For instance, if the
selected object is a grandchild of the home page, the parent page and the 
grandparent page (the home page) will be shown in the Link Info window.

Follow button Follows the links into and out of the selected object. When you click Follow, the 
main-route object that the link points to is selected in Tree view and Cyberbolic view.
If the link is an InLink, the main-route object where the link originates is selected 
instead. 
Tip: If you follow a link to a hidden object, Site Analyst displays and selects the 
object in Tree view, but it will be disabled. In Cyberbolic view, the parent object is 
selected.

Back button Reselects the original object and link. Note: After following a link, if you 
subsequently click other objects in the map, you can’t use the Back button.

View Click View to see the selected object in your browser, or if the object is audio, to 
hear the selected object.

Columns button Displays the Configure Columns dialog box , where you can change the column 
arrangements (properties) of the Link Info window.

RELATED TOPICS
Managing Links (User’s Guide) 



Configure Columns dialog box (Link Info window)

Use this dialog box to change the column arrangements of the Link Info window.

To access this dialog box:

From the Link Info window, click the Columns button.

Field Description

Available Properties Lists the column arrangement properties. You can add one property at a time 
with the Add button, or add all the properties by clicking the Add All button. 
Likewise, you can remove one property or all the properties.

Show These Properties Lists the properties (column arrangements) included in the currently visible object
type in the Quick Columns list. You can move properties up or down to find the 
order you like for the column arrangement.

RELATED TOPICS
Link Properties (Link Info window)
Managing Links (User’s Guide) 



Link Properties (Link Info window)

Use this dialog box to obtain link information about each object in the map. For example, you can
see all pages in the site that have a link to a specified object.

For each link associated with the object, you can also see the link properties (hyperlink text, link 
URL, number of hits the link has received, to name a few). For a detailed list of the available 
properties, see the User’s Guide.

To see different types of links:

1. Click the buttons at the top of the window. The total number of links of the selected 
type appears at the bottom of the window. The buttons are:
Links on Page: For pages only, shows all links on the selected page.
InLinks: Shows all links that point to the selected object from other pages (these 
links are referred to as InLinks). InLinks may be from pages in the same site, or from
another site (if you've imported usage data, or if you’ve explored other sites in 
addition to the “home” site).
Main Route: Shows all ancestor links on the main route to the selected object. For 
instance, if the selected object is a grandchild of the home page, the parent page 
and the grandparent page (the home page) is shown in the Link Info window. 

RELATED TOPICS
Link Info window 
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Labels dialog box

Use this dialog box to change how objects are labeled in the map and to save your label settings 
as the default label settings.

To access this dialog box:

· Choose View|Labels.

· Click  on the Main toolbar.

Field Description

Apply to All Object 
Types

Uses the same labels for all object types.

Object Type Specifies a particular object type. The labels available for each object type are shown 
in the First Choice list. See the User’s Guide.

First Choice Shows the labels available for the specified object type.
If First Choice Not 
Available

An alternate label choice for the specified object type, if the first choice is not 
available.

Cyberbolic Pop-up 
Label

Specifies the pop-up label that appears when you place your cursor over an object in 
Cyberbolic view. The two choices are:
Use Node Label: Use the same label settings as the “main” labels in Tree view.
Use Alternate Label: Use an alternate choice from the list.

Load Default button Loads the default settings for existing maps. These default settings are either the 
defaults that ship with Site Analyst, or your customized label settings that you saved 
as the default.

Save As Default button Saves your customized label settings as the default, which is then used with all new 
maps. Existing maps use whatever label settings were in effect when you saved the 
map.

RELATED TOPICS
Object types (Labels dialog box) 
Changing the Cyberbolic pop-up label 
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Object types (Labels dialog box)

The available object types are shown in the following table, along with the default label settings 
that come with Site Analyst. (If you’re using a WebMap published by someone else, the defaults 
may have been changed by the WebMap publisher.)

Object Type Included MIME Types Default First 
Choice Label

Default Alternate 
Choice Label

Pages HTML pages, HTML pages with data-entry form Name (TITLE 
by default)

Hyperlink Text

Images GIF, JPEG, and other types of images ALT String Link URL

Gateways CGI script files, which may be written in C, PERL, or 
some other programming language

Hyperlink Text Link URL

Internet 
Services

FTP, Telnet, Mailto, WAIS, NNTP, Gopher, and all 
other Internet services (except HTTP)

Hyperlink Text Link URL

Other All other object types and applications that aren’t 
included in other object categories, including 
WebMaps, audio and video files, text files, 
PostScript, Java applets and other applications, and 
PDF files

Hyperlink Text Link URL

Alternate 
routes

All secondary occurrences of objects in the WebMap 
(green labels)

Hyperlink Text Corresponding 
Object Label

RELATED TOPICS
Labels dialog box 



General tab (Program Options dialog box)

Use this tab to configure a variety of program options.

To access this tab:

· Choose View|Program Options, and click the General tab.

Field Description

Browser Path and file name of the browser you want to use as the default Web browser. 
When you double-click an object in the map, Site Analyst launches your default 
browser to display the object.

Synchronize WebMap to 
Browser Location

When checked, the map stays in sync with your browser; the selected object 
changes in the map to reflect the page you’ve traveled to with your browser. 
When unchecked, the map and browser no longer stay in sync.

In Results Window, Change
Columns Based on Object 
Type

When checked, the results window automatically displays the default column 
arrangement properties for the objects you searched for. 

RELATED TOPICS
Site Analyst Setup (User’s Guide) 



Helpers tab (Program Options dialog box)

Use this tab to configure a variety of program options.

To access this tab:

· Choose View|Program Options, and click the Helpers tab.

Field Description

Object Type Shows the available object types: Pages, Images, Other, Gateways (all CGI [*.cgi] and 
Perl [*.pl] scripts), and Internet Services (for example, Telnet, WAIS, FTP, Gopher, Mail, 
and News)

Helper Applications Web browsers and source file editors, such as HTML editors, word processors, 
graphics programs, sound editors, and so on. When you add a helper application (with 
the Add button), this field is automatically filled in with the name of the helper 
application.

Menu Text Displays the executable file name (for example, Notepad) of the helper application. 
When this option is selected, this file name appears in the Launch Helper App submenu
(on the Tools menu) and in the right-click menu.

Application Specifies the executable path and file name of the helper application. For example, the 
executable file for MS Word is C:\MSOFFICE\WINWORD\winword.exe. (You can just 
type winword and Site Analyst fills in the rest.)

Parameters Displays symbols for types of information about the helper application. Click the File 
Param button to view the choices.

Add button Displays the Add Helper Application dialog box, where you can enter the executable file
name (for example, Notepad).

Delete button Deletes the highlighted helper application.
Browse button Displays the Open Application dialog box, where you can search for the executable file 

name of the helper application you want to add.
File Param button Click this button to view the parameter choices, which are: 

URL: The object’s Full URL, taken from the Properties dialog box.
Local Path: The path to the object’s corresponding file on the local hard disk, taken 
from the Properties dialog box.
Source Path: The object’s source path annotation, taken from the Properties dialog 
box.
Local Path URL/Full URL: The object’s local path expressed as a URL, or the Full 
URL if no local path is available.

RELATED TOPICS
Properties dialog boxIDH_D_NOTES_PROPERTY_PAGE 
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Add Helper Application (Program Options dialog box)

Use this option to add the executable file name of the helper application.

To access this option:

· Choose View|Program Options, click the Helpers tab, then click Add.

Field Description

Application Type the executable file name of the helper application (for example, Notepad). Use the 
Browse button to search for the file name, if you like. This name will then appear on the 
Launch Helper App submenu on the Tools menu and in the right-click menu. 



Proxy tab (Program Options dialog box)

Use this tab to configure a variety of program options.

To access this tab:

· Choose View|Program Options and click the Proxy tab.

Field Description

Disable Proxy Services When checked, all current proxy configuration settings are maintained, and 
the other fields in the dialog box are inactive.

Custom Proxy Configuration Activates the dialog box fields so you can customize your proxy services.
IP Address or Machine Name The IP address or machine name of the proxy server. This is a URL 

containing the Internet domain name and port number. For example, 
boomer.mycompany.com:8080.

Port The port number of the proxy server. This is required as part of the machine 
name. This number is separated from the machine name by a colon. In the 
following example, 8080 is the port number: boomer.mycompany.com:8080.

User Name The user name. 
Password The password.
Bypass Proxy On A list of IP addresses that you can access without going through the proxy 

server. Typically this is for access to Web resources on a local area network 
inside the firewall. You enter these IP addresses in the Add Proxy Bypass 
dialog box.

Add button Displays the Add Proxy Bypass dialog box, where you can add IP addresses 
that won’t go through the proxy server.

Delete button Displays a warning asking if you want to delete the selected address. Click 
OK.

RELATED TOPICS
Site Analyst Setup (User’s Guide) 



Add Proxy Bypass (Program Options dialog box)

Use this option to add proxy server addresses.

To access this option:

· Choose View|Program Options, click the Proxy tab, then click Add.

Field Description

IP Address or 
Machine Name

The IP address or machine name of the proxy server. This is a URL containing the Internet 
domain name and port number. For example, boomer.company.com:8080.

Port The port number of the proxy server. This is required as part of the machine name. This 
number is separated from the machine name by a colon. In the following example, 8080 is the 
port number: boomer.mycompany.com:8080.

Add button Adds the machine address to the Bypass Proxy On list field. If you need to add more than one 
address, click the Add button after you input each address. When you’ve finished adding 
addresses, click Close and the addresses appear in the Bypass Proxy On list field.

RELATED TOPICS
Site Analyst Setup (User’s Guide) 



Cyberbolic tab (Program Options dialog box)

Use this tab to configure a variety of program options.

To access this dialog box:

· Choose View|Program Options and click the Cyberbolic tab.

Field Description

Center Selected Node on 
Mouse Click

Selected by default. This option moves the object you select to the center of the
view.

Enable Snap Mode Cleared by default. This option makes objects appear immediately in their new 
positions, rather than gliding to their new positions.

Show Common Ancestor 
When Selecting in Tree View

Selected by default. As you select objects in Tree view, the Cyberbolic view 
pauses its movement briefly to highlight the common ancestor before settling 
on the next object you select in Tree view. 

Show Busiest Link Selected by default. If you’ve imported usage data into your map, you can 
choose to display the busiest links between objects with a special colored line
—magenta—in Cyberbolic view.

RELATED TOPICS
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Passwords tab (Program Options dialog box)

Use this tab to configure a variety of program options.

To access this dialog box:

· Choose View|Program Options and click the Passwords tab.

Field Description

Domain The full URL of the site.
Realm Enter the realm name, which is a server-specific name for a protected area 

or directory. (Your server administrator can give you this information if you 
don’t know it. See the User’s Guide, “Microsoft Site Analyst Setup,” for 
details on realms and authentication schemes.) 

User ID Enter the user ID (in most cases, the username).
Password Enter the password. 
Add button Click this button to add passwords for password-protected pages in your 

site.

RELATED TOPICS
Microsoft Site Analyst Setup (User’s Guide)  



Add Passwords (Program Options dialog box)

Use this option to add password information, which is stored on the server.

To access this option:

· Choose View|Program Options, click the Passwords tab, then click Add.

Field Description

Domain The full URL of the site.
Realm Enter the realm name, which is a server-specific name for a directory. (Your 

server administrator can give you this information if you don’t know it.)
User ID Enter the user ID (in most cases, the username).
Password Enter the password. 

RELATED TOPICS
Microsoft Site Analyst Setup (User’s Guide)  



Compare and Update dialog box

Use this dialog box to compare and update two maps to see the current state of the site.

To access this dialog box:

· Choose Tools|Compare and Update.

· Click  on the Main toolbar.

Field Description

Source WebMap The map with customizations you want to preserve, usually the older of the two 
maps.

Target WebMap The map that you may want to update with the source map’s customizations, 
usually the newer of the two maps.

Report on Changed and 
New Objects in Target 
WebMap

Generates a comparison result for new and changed objects in the target map.

Report on Orphaned 
Objects in Source WebMap

Generates a comparison result for objects in the source map that aren’t found in 
the target map.

Update Annotations from 
Source WebMap to Target 
WebMap

Updates the target map with the customizations of the source map.

RELATED TOPICS
Comparing and updating maps 
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Verify Links dialog box

Use this dialog box to verify onsite and offsite links.

To access this dialog box:

· Choose Mapping|Verify Links.

· Click  on the Main toolbar.

Field Description

OnSite Links Verifies links that refer to an object on the same site. You can verify all links or only broken 
links.

OffSite Links Verifies links that refer to an object on a different site from the object where the link resides.
You can verify all links or only broken links.

Verify button Click the Verify button to start the verification process.

RELATED TOPICS
Verifying offsite links 
Managing Links (User’s Guide) 



General tab (Statistics dialog box)

Use this tab to view general information about the site.

To access this dialog box:

· Choose View|Site Statistics.

· Click  on the Main toolbar.

Field Description

Domain The full URL of the site.
Root Path The directory path of the site’s home page.
Home Page The page (file name) from which you start mapping a Web site. Usually the home 

page, but can be any page in the site.
CGI Bin 
Directory

Specify the directory where any Common Gateway Interface (CGI) script programs 
reside.

RELATED TOPICS
Object Count tab (Statistics dialog box) 



Object Count tab (Statistics dialog box)

Use this tab to view the number of objects and links in the map: pages, hyperlinks, images, 
gateways, audio or video files, Internet services, text files, other applications, and any 
unrecognized MIME types.

To access this dialog box:

· Choose View|Site Statistics.

· Click  on the Main toolbar.

RELATED TOPICS
General tab (Statistics dialog box) 



General tab (Properties dialog box)

Use this tab to obtain object and link information, and to hide all routes and all alternate routes to 
an object. The Properties dialog box can remain on your screen at all times. As you select each 
object, the properties change accordingly.

To access this tab:

· Choose View|Object Properties, and click the General tab.

· Click  on the Main toolbar.
· Right-click the object and choose Properties.

Field Description

URL The full URL (Uniform Resource Locator) or Internet address for an object, including the 
protocol, domain nameFor example, http://www.microsoft.com.

Local Path The complete local directory path and file name, starting with the drive letter; for example,
c:\myfiles\project\phas2\base.htm. When you copy a site locally or map from a file, the 
local path is automatically added. This is a read-only field.

MIME Type The object’s specific MIME types. For example, an HTML page would be labeled 
text/html.

Modified Date The date the object was last modified.
Size The size of the object in bytes.
Explore (HTTP) 
Status

Lists whether the object is explored or unexplored with its HTTP status code in 
parentheses (for example 200 means the object was found; 400 means the object was 
unreachable).

Hide All Routes Lets you hide all routes to an object.
Shortcut: Select the object and press Ctrl+H. This automatically hides all routes to the 
object.

Hide All Alternate 
Routes

Lets you hide the alternate routes to an object (so that just the main routes are showing). 
You cannot hide just one alternate route to an object; you must hide all or none of them.

From URL The URL of the object’s parent page.
Hyperlink Text The text (if any) used in the link reference on the object’s parent page.
Link URL The Link URL as specified on the object’s parent page. The Link URL is most often 

relative (that is, the path name is relative to the site’s parent page).

RELATED TOPICS
Managing Links (User’s Guide) 
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Annotations tab (Properties dialog box)

Use this tab to enter information about the selected object (including public and private notes, 
author and date, and the source path to a file. Also, if you use META tags in your HTML pages, 
the META data will be imported automatically when you create a map, as long as the NAME 
attributes are exactly the same as any of the fields on the Annotations tab.

To access this tab:

· Choose View|Object Properties and click the Annotations tab.

· Click  on the Main toolbar.
· Right-click the object and choose Properties.

Field Description

Name The object’s name. You can enter anything you like in this field. By default, the Name field 
for pages is the TITLE tag.

Source Path The object’s source path. In many cases, the file for the Web resource has been converted 
from a different format. For example, if you edit a file in Microsoft Word and then convert the
file into an HTML page, you can go back and search on the original “source” path of the 
Word file.

Author Use this field to record the name or e-mail address of the person responsible for 
maintaining this object. This is especially useful for Webmasters who have multiple authors 
working on a Web site.

Date This date that can be used for tracking, such as due date of a project, “review-by” date, or a
milestone date. The date format is retrieved from the Windows Regional Settings in the 
Control Panel.

Notes You can enter notes about any object. If you’ve entered no other notes, the hyperlink text (if 
any) appears in the Notes field. These notes get published with the map.

Private Notes These notes are private and do not get published with the map. You can use private notes 
as reminders about managing your site, or for any information that you may want to search 
for later.

RELATED TOPICS
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Page tab (Properties dialog box)

Use this tab to obtain information about the selected page. The properties on this tab apply to 
text/HTML object types or to text/HTML with a form.

To access this tab:

· Choose View|Object Properties and click the Page tab.

· Click  on the Main toolbar.
· Right-click the object and choose Properties.

Field Description

Title By default, the HTML TITLE tag. This is copied from the Name field in the Annotations tab.
Hyperlink Text The text (if any) used for the link reference of the object’s parent page.
Headings On an HTML page, text that has been formatted with one of several header tags: H1, H2, H3, 

and so on. You can use the first heading encountered on HTML pages as a label for pages.
Size The size of the HTML page in bytes.
Load Size The full loading size (when loaded by a Web browser) of the page, including all inline images, 

audio and video files, and so on.
Modified Date The date the object was last modified. You can use this Date field as a search condition; for 

example, you can search for all pages that have a modification date greater than 1/1/96.

RELATED TOPICS
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More Page Info tab (Properties dialog box)

Use this tab to obtain tag and attribute information (the ones you can search for in the Search 
dialog box) that you might have in your HTML files. For example, BGCOLOR, ISMAP, ALIGN, 
META, just to name a few. For a complete list of searchable attributes, see Searching Maps and 
Creating Custom Reports (User’s Guide). 

To access this tab:

· Choose View|Object Properties and click the More Page Info tab.

· Click  on the Main toolbar.
· Right-click the object and choose Properties.

Field Description

Other Page 
Tags/Attributes

Lists tags and attributes that you’ve used in your HTML pages. You can search for 
particular tags to see which pages the tags reside on.

RELATED TOPICS
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Image tab (Properties dialog box)

Use this tab to obtain information about images.

To access this tab:

· Choose View|Object Properties and click the Image tab.

· Click  on the Main toolbar.
· Right-click the object and choose Properties from the right-click menu.

Field Description

Image Type The type of image, for example image/gif.
Image Attributes Any image attributes, such as Inline, which indicate that the image is to be downloaded and 

displayed in the Web page.
Size (bytes) The size of the image in bytes.
Imagemap URL The URL of a server-side imagemap, a file that describes clickable areas of an image and 

the multiple URLs of the associated resources.
Attribute Lists the attributes of the IMG tag: ALT ALIGN, HEIGHT, and WIDTH.
ALT The optional text string in an HTML IMG tag used to describe the associated image. This 

accommodates people with nongraphical browsers or who have turned off graphics 
downloading.

ALIGN The value of the ALIGN attribute in the IMG tag, which defines the alignment of an image: 
either left (the default), center, or right.

HEIGHT The value of the HEIGHT attribute in the IMG tag, which specifies the height of the image (by
default, in pixels).

WIDTH The value of the WIDTH attribute in the IMG tag, which specifies the width of the image (by 
default, in pixels).

First Link Value Lists the value of the first instance of the link found for the image attributes.
ALT The text of the ALT String.
ALIGN The alignment of the image: center, left, or right.
HEIGHT The height of the image in pixels.
WIDTH The width of the image in pixels.
Usage Lists the usage of the image attributes.
ALT If the image does not contain the ALT attribute, Absent is displayed. If the image does 

contain this attribute, and the image is used more than once in the HTML file, Consistent or 
Inconsistent usage is displayed.

ALIGN If the image does not contain the ALIGN attribute, Absent is displayed. If the image does 
contain this attribute, and the image is used more than once in the HTML file, Consistent or 
Inconsistent usage is displayed.

HEIGHT If the image does not contain the HEIGHT attribute, Absent is displayed. If the image does 
contain this attribute, and the image is used more than once in the HTML file, Consistent or 
Inconsistent usage is displayed.

WIDTH If the image does not contain the WIDTH attribute, Absent is displayed. If the image does 
contain this attribute, and the image is used more than once in the HTML file, Consistent or 
Inconsistent usage is displayed.

RELATED TOPICS



General tab (Properties dialog box) 
Page tab (Properties dialog box) 
Annotations tab (Properties dialog box) 
Gateway tab (Properties dialog box) 



Gateway tab (Properties dialog box)

Use this tab to obtain information about gateways. The Properties dialog box can remain on your 
screen at all times, and as you select each object, the properties change accordingly.

To access this tab:

· Choose View|Object Properties and click the Gateway tab.

· Click  on the Main toolbar.
· Right-click the object and choose Properties from the right-click menu.

Field Description

Language The programming language the gateway script is written in (you can also select it). If 
you want to use Language as a label type, you’ll need to specify the language here 
for each object (since Site Analyst has no other way of knowing what the language 
is).

Return Type Page, URL, URL/Page (default). If you want to use Return Type as a label, you’ll need to enter 
it in the Properties dialog box for each object (since Site Analyst has no other way of knowing 
what the return type is).

Method POST or GET. This is the method by which data entered in a form is passed to the CGI script 
for processing.

RELATED TOPICS
General tab (Properties dialog box) 
Page tab (Properties dialog box) 
Annotations tab (Properties dialog box) 
Image tab (Properties dialog box) 



Empty Properties Page

You have closed a map with the Properties dialog box still open. Since there are no properties 
available, the Properties dialog box is empty. Open a map, right-click an object, and select 
Properties.

RELATED TOPICS
General tab (Properties dialog box) 



About Site Analyst

Microsoft Site Analyst™ is the advanced navigation tool for mapping the World Wide Web and for
managing your Web site. Whether you’re a Webmaster, an information architect, or a site 
publisher, Microsoft Site Analyst gives you the tools you need to solve your site management 
problems. 
For more information about this product, see the online User’s Guide. 



Import Usage Data dialog box

Use this dialog box to import information about how people are using your site. Usage data 
consists of one or both of these types of information:

· A tally of the number of times a page or other site resource was accessed during a certain 
time period, often called hit count.

· A list of the URLs from which other Web users are clicking hyperlinks to hit your site—that is, 
the Referrers.

To access this dialog box:

· Choose File|Import Usage Data.

Field Description
File name Enter the file name (or browse for it).
Referrers Only Imports only the URLs from which the hits originated.
Referrers and Hits Imports both hits and referrer URLs.
Replace Previous Replaces the previous hit count information and imports the most recent hit counts.
Accumulate Imports a cumulative total of all hit counts since you first started importing usage data.
Set Routes by Hits Resets the routes in your map so that the busiest links have the most prominence in the 

hierarchy.

RELATED TOPICS
Site Management Tips and Techniques (User’s Guide) 



Export Tree View dialog box

Use this dialog box to export the Tree view as an HTML file, or as a tab-delimited text file into a 
spreadsheet or database.

To access this dialog box:

· Choose File|Export|Tree View.

Field Description

Format Choose HTML or Tab Delimited Text.
File name Accept the default path and file name or enter a different one (or browse for it).

RELATED TOPICS
Exporting to HTML format 



Export Results dialog box

Use this dialog box to export the results window as an HTML file, or as a tab-delimited text file 
into a spreadsheet or database.

To access this dialog box:

· Choose File|Export|Results.

Field Description

Format Choose HTML or Tab Delimited Text.
File name Accept the default path and file name or enter a different one (or browse for it).

RELATED TOPICS
Exporting to HTML format 



Export Link Info dialog box

Use this dialog box to export the Link Info window as an HTML file, or as a tab-delimited text file 
into a spreadsheet or database.

To access this dialog box:

· Choose File|Export|Link Info.

Field Description

Format Choose HTML or Tab Delimited Text.
File name Accept the default path and file name or enter a different one (or browse for it).

RELATED TOPICS
Exporting to HTML format 



General tab (Mapping from File Options dialog box)

Use this tab to view and change mapping options.

To access this tab:

· Choose File|New|Map from File, and click the Options button on the dialog box. Select the 
General tab.

· Choose Explore|Site or Branch, and click the Options button on the dialog box.
· Choose Mapping|MappingOptions. (The map you’re working with must have been created 

from a local file or networked filesystem. Otherwise, the Mapping from URL Options dialog 
box will appear.)

Field Description

Creation Options Lists map creation options.
Ignore Case of URLs When checked, this option ignores the capitalization of URLs that Site Analyst 

looks up. 
Exploration Options Lists the exploration options.
If No Default File, Map All 
Files in Directory

Selected by default, this option “cooks up” a temporary page consisting of links 
to every file in the referenced directory. This action applies only when Site 
Analyst finds links that point to a directory that uses a trailing slash and does 
not contain a default file name. When this option is cleared, Site Analyst reports
these links as broken.

Verify Offsite Links (Site 
Analyst Pro Edition)

Verifies (looks up) offsite links (links to objects on other sites). Site Analyst only 
verifies that each offsite link exists; it doesn’t look up any of the links on an 
offsite page. A question mark will still appear next to the offsite object in the 
map.

Honor Robot Protocol When checked, this option ensures that Site Analyst will not explore any area of
a site that is set up to keep out spiders. Note: If you use the Extensions tab to 
explore additional offsite domains, Site Analyst will automatically obey any robot
protocol that has been set up for those sites.

Local Site Root Directory When you first create a map from a filesystem, this option is informational only; 
it shows you the site root that you entered in the Home Page Path and File 
name box in the New Map from File dialog box. Later, if you move your site to a
different filesystem location, or you want to share the map with others who have
mapped a local drive to a different drive letter, you may want to change the 
local path.

RELATED TOPICS
Creating a map from a filesystem 
Verifying offsite links 
General tab (Mapping Options dialog box) 
Site Copy tab (Mapping from URL Options) 
Extensions tab (Mapping Options) 
Restrictions tab (Mapping Options) 



General tab (Mapping from URL Options dialog box)

Use this tab to view and change mapping options.

To access this tab:

· Choose File|New|Map from URL, and click the Options button on the dialog box. Select the 
General tab.

· Choose Mapping|Mapping Options. (The map you’re working with must have been created 
from a URL. Otherwise, the Mapping from File Options dialog box will appear.)

Field Description

Creation Options Lists map creation options.
Ignore Case of URLs When checked, this option ignores the capitalization of URLs that Site Analyst 

looks up. 
Ignore Default WebMaps When checked, this option ignores any default WebMaps found on the site 

you’re mapping. (Some Webmasters create maps of their sites and post them. 
Site Analyst detects this map and displays it in the map window.)

Exploration Options Lists the exploration options.
Verify Offsite Links Verifies (looks up) offsite links (links to objects on other sites). Site Analyst only 

verifies that each offsite link exists; it doesn’t look up any of the links on an offsite
page. A question mark will still appear next to the offsite object in the map.

Honor Robot Protocol When checked, this option ensures that Site Analyst will not explore any area of 
a site that is set up to keep out spiders. Note: If you use the Extensions tab to 
explore additional offsite domains, Site Analyst will automatically obey any robot 
protocol that has been set up for those sites.

User Agent Lists you enter of the user agent you want Site Analyst to employ when it maps 
the site. The most common choices are: Microsoft (the default), Mozilla 2.0, and 
Mozilla 3.0. 

RELATED TOPICS
Creating a map from a URL 
Verifying offsite links 
General tab (Mapping Options dialog box) 
Site Copy tab (Mapping from URL Options) 
Extensions tab (Mapping Options) 
Restrictions tab (Mapping Options) 



Site Copy tab (Mapping from URL Options dialog box)

Use this tab to view and change mapping options. Use the Site Copy tab to copy a site from a 
Web server to your local hard disk as Site Analyst builds the map.

To access this tab:

· Choose File|New|Map from URL, and click the Options button on the dialog box. Select the 
Site Copy tab.

· Choose Mapping|Mapping Options. (The map you’re working with must have been created 
from a URL. Otherwise, the Mapping from File Options dialog box will appear.)

Field Description

Copy Site When checked, this option copies a site from a Web server to your local hard disk as 
Site Analyst builds the map. If the directory already contains one or more files, Site 
Analyst displays a warning message. You can still copy the site, but some files may be 
overwritten.
Note: Be sure to select Ignore Default WebMaps on the General tab. If you don’t, Site 
Analyst might not copy all the files you expect it to.

Local Site Root 
Directory

Enter the directory name (or browse for it) where you want to copy the site.

RELATED TOPICS
Creating a map from a filesystem 
Extensions tab (Mapping Options) 
Restrictions tab (Mapping Options) 



Extensions tab (Mapping Options dialog box)

Use this tab to explore additional domains when you create a map.

To access this tab:

· Choose File|New|Map from URL or Map from File, and click the Options button on the dialog 
box. Select the Extensions tab.

· Choose Mapping|Mapping Options.

Field Description

None When this option is selected (as it is by default), no extensions are activated.
All Other Domains Explores all other domains (or relative paths if you’re mapping on a filesystem) 

when mapping the site.
Auto-Explore URLs 
Starting With

When checked, this option explores the domains you specify. When you add 
domains or paths, they are automatically listed in the area below this button.

New Entry Enter the domain and click Add. You can also add areas of your site that are not 
directly off the site root. For example, if you start mapping at www.mysite/products, 
and you keep all your site’s graphics in a directory called www.mysite/graphics, 
you’ll need to add www.mysite/graphics to the Extensions list, since Site Analyst 
would only map resources linked to the products subdirectory and below.

Warning: If the Explore Entire Site checkbox is checked on the New File dialog box, Site Analyst 
will explore all sites you’ve specified on the Extensions tab (in addition to the exploring the site 
you’re mapping). This includes public Web sites that you have links to in your site. This process 
could take a very long time if any of these sites are large.

RELATED TOPICS
Creating a map from a URL 
General tab (Mapping Options dialog box) 
Restrictions tab (Mapping Options) 



Restrictions tab (Mapping Options dialog box)

Use this tab to ignore the particular domains or paths you specify when Site Analyst creates a 
map.

To access this tab:

· Choose File|New|Map from URL or Map from File, and click the Options button on the dialog 
box. Select the Restrictions tab.

· Choose Mapping|Mapping Options.

Field Description

Restrictions When checked, Site Analyst ignores the particular domains or paths you specify 
when it creates a map.

New Entry Enter the domain or path you want to exclude from being mapped, and click Add. 
When you add a domain or path, it is automatically listed in the area below this 
button.
Note: If you’re mapping from a filesystem, do not enter the full local path. Instead, 
enter just the site root. For example, in this full local path, g:\mysiteroot\products, 
you would only enter \products.

RELATED TOPICS
Creating a map from a URL 
General tab (Mapping Options dialog box) 
Extensions tab (Mapping Options) 



Remap dialog box

Use this dialog box to remap a site once you’ve made changes and corrections to your site.

To access this dialog box:

· Choose Mapping|Remap Site.

Field Description

Explore Options These options allow you to analyze any additions, deletions, or changes 
you’ve made to the site.

      Entire Site Explores the entire site. You can analyze any additions, deletions, or changes
you’ve made to the whole site.

      Previously Explored Pages Explores only the previously explored pages. You can analyze any additions, 
deletions, or changes you’ve made to the level you explored previously.

Update Options These options allow you to update the map with options you may not have 
set up originally.

      Verify Offsite Links Verifies links that point to an object on a different site from the page on which 
the link resides.

      Set Routes by URL Sets the map routes by URL hierarchy. This organizes your map according to
how your site is actually structured, not according to the order in which the 
links are discovered on pages.

      Copy Annotation Copies annotations from the original map of the site into this map. This way, 
you don’t lose any notes you may have entered or changed for the original 
map (on the Annotations tab of the Properties dialog box). Note: This does 
not copy over any META tag data that is imported with the map.

Reporting Options These options allow you to generate the listed reports to further analyze your 
changes.

      Generate Site Reports Generates the standard site reports (summary, index, broken links, and so 
on).

            Report Directory Enter a directory name or browse for it.
            Report Prefix Enter a report prefix name.
      Show “Changed and New
        Object” Results Window

Generates a results window of what’s new and changed in your site. Any 
objects that have been modified or added to the site will show up in the 
results window.

      Show “Orphaned” Results
        Window

Generates a results window of objects that have been “orphaned” in the 
latest version of your site. This allows you to delete extraneous site 
resources, or see where you may have deleted links to a still-relevant 
resource.

Replace Original Map (and 
Rename Original as 
“.bak.wmp.”)

Replaces the original map with the current map, and renames the original 
map as <file name> .bak.wmp.

RELATED TOPICS
Remapping a site 
Site Management Tips and Techniques (User’s Guide) 
Help on Reports 
Exploring a site or branch of a map 





Generate Site Reports dialog box

Use this dialog box to generate site analysis reports. 

To access this dialog box:

· Choose Tools|Generate Site Reports.

· Click  on the Main toolbar.
· From the File|New|Map from URL dialog box, check the Generate Site Reports checkbox. 

(This option lets you generate reports when you create a new map.)

Field Description

Report Directory Specifies the location for the report directory. You can accept the default location 
directory or enter your own (or browse for it).

Report Prefix Specifies the report prefix name. You can accept the default name, or enter any 
name you like. Site Analyst automatically appends a suffix of html for each report 
name. For example, the default report name for the Microsoft site summary report 
would be microsoft_summary_.html.

Save Copy of Map to 
Report Directory

When checked, Site Analyst saves a copy of the map (for example 
www.microsoft.wmp) with the site reports.

RELATED TOPICS
Working with HTML Reports (User’s Guide) 
Help on Reports 



Set Routes dialog box

Use this dialog box to set the routes in both views according to the URL hierarchy of the site or 
usage data.

To access this dialog box:

· Choose Mapping|Set Routes.

Field Description

Set Routes by
      URL Hierarchy Sets the main routes according to the URL hierarchy of the site. This organizes your map 

according to how your site is actually structured, not according to the order in which the 
links are discovered on pages.

      Usage Data (Hits) Sets the main routes according to the busiest link to each object. The busiest links are 
most prominent in the map.

RELATED TOPICS
Creating a map from a URL 
Anatomy of a WebMap (User’s Guide) 
Site Management Tips and Techniques (User’s Guide) 



Node Distance

Use this dialog box to determine how far apart you want to display map objects in Cyberbolic 
view. 

To access this dialog box:

· Click  on the Cyberbolic toolbar.

Slide the indicator between Near and Far until the distance between objects is adjusted to your 
liking.

RELATED TOPICS
Display Options dialog box 
Changing the node distance in Cyberbolic view 



Quick Search Descriptions

Choose Tools|Quick Searches and then select the quick search you want.

The Quick Search descriptions are listed in the following table.

Hidden Objects Searches for pages and other resources that are currently hidden, 
either individually (via the View|Hide Object command) or by object 
type (with the View|Display Options dialog box).

Home Site Objects Searches for pages and other resources on the same domain as the 
site’s home page.

Images Without ALT Searches for images that don’t have the optional ALT attribute text 
string.

Load Size Over 32K Searches for pages whose load size (the size of the HTML page plus 
any linked inline resources, such as images) is larger than 32K.

Non-Home Site Objects Searches for pages and other resources on a different domain than the
site’s home page.

Not Found Objects (404) Searches for pages and other resources that didn’t exist on the server 
when Site Analyst mapped the site.

Objects with Referrals Searches for offsite InLinks that have been imported as usage data.

Unavailable Objects Searches for pages and other resources that couldn’t be reached when
Site Analyst mapped the site. For a list of common HTTP error codes, 
see “Managing Links” in the User’s Guide.

Unverified Objects Searches for pages and other resources for which one or more links 
have been found, but which have not been verified as accessible.

RELATED TOPICS
Using Quick Searches 
Setting up the Search dialog box 
Display Options dialog box 



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Creating and Customizing WebMaps.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Anatomy of a WebMap.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Working with HTML Reports.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Managing Links.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select All About Routes.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Searching Maps and Creating Custom Reports.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Site Management Tips and Techniques.



Getting to the HTML Help for reports…

…is only clicks away! Here’s how:

1. Select the Tools menu.
2. Choose Generate Site Reports.

Fill in the information in the dialog box.

The Summary report automatically appears in your browser.

3. Click the word, Help, at the top of each report.



Getting to the online User’s Guide for this topic…

…is only three clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select Site Analyst Setup.



Getting to the online User’s Guide…

…is only two clicks away! Here’s how:

1. Select the Help menu.
2. Choose User's Guide.

The Welcome file appears in your browser. 

3. Select the topic you want and go from there!





Mapping Tasks

Listed below are the most common tasks you can do in Site Analyst. Be sure to read the online 
User’s Guide (accessible from the Help menu) for complete information about all the tasks you 
can perform. 

Choose from the following list for instructions on how to perform these tasks:

Basic tasks Advanced tasks

Opening a map Creating quick searches 

Saving a map Setting up the Search dialog box 

Printing a view or results Changing properties and column order in the 
Results window 

Exporting to HTML format Changing how properties are sorted 

Creating a map from a URL Importing usage data 

Creating a map from a filesystem Using META tags in your maps 

Viewing map objects in your Web browser Changing properties and column order in the 
Link Info window 

Exploring a site or branch of a map Comparing and updating maps 

Exploring a particular page Changing how alternate routes are displayed 

Hiding objects Resetting the routes 

Hiding all alternate routes Changing the map’s local path 

Locating and redisplaying hidden objects Configuring helper applications 

Changing default mapping options Creating an HTML table of contents of your site

Changing the default display options Creating an HTML index of your site 

Changing labels for object types Using HTML Reports 

Remapping a site Verifying offsite links

Using Quick Searches Locating links to a changed resource (InLinks) 

Publishing a map Locating orphans 

Adding a default map to your Web site 

Opening a map

To open a map, use one of these methods:

· Choose File|Open or click  on the Main toolbar. The standard Windows Open dialog box 
appears. Enter (or browse for) the name of the map you want to open.

· From the desktop, Windows Explorer, or File Manager, drag any map file to the Site Analyst icon 



or into the map window. Or, just double-click any map file.



Saving a map

To save a map:

1. Choose File|Save or File|Save As (to save the map under a new name) or click  on 
the Main toolbar. The standard Windows Save dialog box appears, suggesting the default
WebMap file extension wmp.

2. Specify a file name and click Save. The map is saved with the current display and label 
settings.



Printing a view or results

To print a map:

1. Choose File|Print|Tree View, or File|Print|Cyberbolic View, or File|Print|Results. Note: You 
have to perform a search or compare and update operation to make the Print|Results 
menu item active.

2. In the Print dialog box, set up your options, and click OK. Site Analyst prints the view or 
results.

Site Analyst prints the view using the current display option and label settings, as well as the 
expansion level currently in effect. Site Analyst prints the results window using the current column
settings.

You can use the Print Preview command on the File menu to see how your view or results will 
appear when they are printed. 



Exporting to HTML format

You can export a map from Tree view only.

To export a map:

1. Set up the map window to display exactly what you want to export.

2. Choose File|Export|Tree View. The Export dialog box appears.

3. Choose HTML from the Format list.

4. Enter (or browse for) the file name. By default, Site Analyst names the file Tree.htm.

5. Click Save. The HTML “snapshot” of the current map window automatically loads into your 
default Web browser.

To export results:

1. Set up the results window to display exactly what you want to export.

2. Choose File|Export|Results. The Export dialog box appears.

3. Choose HTML from the Format list.

4. Enter (or browse for) the file name. By default, Site Analyst names the file Search.htm (or 
Compare.htm if you’ve done a comparison operation).

5. Click Save. The HTML “snapshot” of the current results window automatically loads into your 
default Web browser.

To export link info:

1. Set up the Link Info window to display exactly what you want to export.

2. Choose File|Export|Link Info. The Export dialog box appears.

3. Choose HTML from the Format list.

4. Enter (or browse for) the file name. By default, Site Analyst names the file Links.htm.

5. Click Save. The HTML “snapshot” of the current Link Info window automatically loads into 
your default Web browser.



Creating a map from a URL

To create a map from a URL:

1. Choose File|New|Map from URL. Shortcuts: Choose  on the Main toolbar, or press 
Ctrl+N and choose the URL button. Click OK. The New Map from URL dialog box appears.

2. Enter a URL.

3. Select your options on the dialog box.

4. For more options, click the Options button. The Mapping from URL Options dialog box 
appears, which offers numerous choices on the various tabs.

5. Click OK.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Creating a map from a filesystem

To create a map from a filesystem:

1. Choose File|New|Map from File. Shortcuts: Choose  on the Main toolbar, or press Ctrl+N 
and choose the File button. Click OK. The New Map from File dialog box appears.

2. Enter the path and file name for the home page (or any other page in the site where you want 
to start mapping). For example, c:\nc\html\winhelp.htm.

3. Enter the domain and root directory for the site (for example, www.microsoft.com). If you want
to start mapping the site from a page other than the site’s home page, add the path to that 
page after the domain name (for example, www.microsoft.com/products/default.asp).

4. If you have CGI scripts in your site, and they’re not located in \cgi-bin (where “\” is the site 
root), enter or browse for their location in the CGI Bin Directory box.

5. Select your options on the dialog box.

6. For more options, click the Options button. The Mapping from File Options dialog box 
appears, which offers numerous choices on the various tabs.

7. Click OK.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Viewing map objects in your Web browser

To view a page or other resource in your browser:

1. In either Tree or Cyberbolic view, double-click the map object. Site Analyst launches your 
Web browser and displays the object.

2. You can arrange the windows so that the map window and your browser are side-by-side. In 
Windows 95, close all applications other than Site Analyst and your browser, then right-click a 
blank area on the Windows taskbar. Choose Tile Vertically from the menu that appears.

3. Continue double-clicking objects to browse the Web directly from your map.



Exploring the site or branch of a map

When you first create a map, you can automatically explore the entire site by checking the 
Explore Entire Site checkbox in the New Map dialog box. If you want to explore a site manually 
when you first create a map, or at any time when you’re working with the map, clear this 
checkbox, and then use the Explore dialog box to specify the options you want and to start the 
exploration process.

To explore a site:

1. Choose Mapping|Explore|Site.

2. Site Analyst will explore the site from the top down, beginning at the home page (or where it 
left off last time you explored), to the limits you specify in this dialog box. (Site Analyst 
Standard Edition limits exploration to 150 pages).

Note: You can set routes in the map by the structure of URLs in your site. 

4. For more options, click the Options button and edit the settings on the various tabs.

To explore a branch of the map:

1. At any point in the map, choose Mapping|Explore|Branch.

2. Site Analyst will explore only that branch of the map, to the limits you specify in this dialog 
box.

Note: You can set routes in the map by the structure of URLs in your site. Note that all routes 
in the map will be set by URL hierarchy, not just this branch.

4. For more options, click the Options button and edit the settings on the various tabs.

For more details on each option, click the Help button on the dialog box.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Exploring a particular page

To explore a page:

· In Tree view, click the question mark icon.
· In Cyberbolic view, right-click the page and choose Explore Page. (The question mark in 

Cyberbolic view is not clickable; it’s just an indicator to tell you the page isn’t explored yet.)

When you explore, the question mark icon does one of the following things:
· It disappears if the page contains no links to other objects.
· In Tree view, it turns into a minus if the page contains one or more links to other objects.
· It remains a question mark if Site Analyst couldn’t access the page. The label will turn red, 

indicating that the page is unreachable.

Note: Site Analyst Standard Edition has a limit of 150 explored pages.

RELATED TOPICS
Managing Links (User’s Guide) 



Hiding objects

When you hide an object, you hide all routes to that object.

To hide an object:

1. Select the object you want to hide. You can select the object in either Tree or Cyberbolic view.

2. Choose View|Object Properties, or choose Properties from the right-click menu. The 
Properties dialog box appears.

3. Select Hide All Routes, and click OK.

Shortcuts: Select the object in the map, and press Ctrl+H.

Select the object in the map, and choose View|Hide Object.

RELATED TOPICS
All about routes (User’s Guide) 
Creating and Customizing WebMaps (User’s Guide) 



Hiding all alternate routes

You must hide all alternate routes to an object, not just one alternate route.

To hide all alternate routes to an object:

1. Select the object that has alternate routes you want to hide. You can select either the main 
route or an alternate route to the object.

2. Choose View|Object Properties or choose Properties from the right-click menu. The 
Properties dialog box appears.

3. Select Hide All Alternate Routes, and click OK. The main route to the object will appear in the 
map window, but all alternate routes will be hidden.

RELATED TOPICS
All about routes (User’s Guide) 



Locating and redisplaying hidden objects

To redisplay hidden objects, search for them as follows:

1. Choose Tools|Quick Search.

2. Choose Hidden Objects. An automatic search occurs for hidden objects. If any are found, they
are displayed disabled in the Search Results window.

3. To redisplay a hidden object, select it in the Search Results window. The object appears 
selected and disabled in the map window. (You may have to minimize the Search Results 
window to see the map window.)

4. To “un-hide” the hidden object, right-click it and choose Properties.

5. Clear Hide All Routes or Hide All Alternate Routes, and click OK. The object appears is no 
longer disabled in the map window.

RELATED TOPICS
Using Quick Searches 
Setting up the Search dialog box 
Searching Maps and Creating Custom Reports (User’s Guide) 



Changing default mapping options

To change the default mapping options:

1. Choose Mapping|Mapping Options, or choose Options from the New Map from URL (or File) 
dialog box.

2. On each tab of the dialog box, change the settings to your liking. Click OK when you’re 
satisfied with your choices.

Mapping options are saved with the map. The next time you open your map, the options will be 
as you last set them. For more details on each option, click the Help button on the Mapping 
Options dialog box .

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Changing the default display options

To change the default display options:

1. Choose View|Display Options, or click  on the Main toolbar. The Display Options dialog 
box appears.

2. Select the Tree or Cyberbolic tab. Change the settings to your liking.

3. Click Save As Default to save your new defaults for the current map and for all new maps you
create.

4. Click OK.

For more details on each option, click the Help button on the dialog box.



Changing labels for object types

To change the label for an object type:

1. Choose View|Label Options, or click  on the Main toolbar. The Labels dialog box appears.

2. To use the same labels for all object types, select Apply to All Object Types. To use different 
labels for each object type, select an object type from the list.

3. Select a First Choice for the label; this will be the default for the selected object type.

4. Select an alternate choice for the label (if your first choice is not available).

If you don’t specify an alternate choice, and the first choice isn’t available, the Link URL will 
be used.

5. Click Apply whenever you want to see how your label choices are affecting the map window.

6. To save your label settings as the default (used with all new maps), click Save As Default. To 
use these label settings on an existing map, click Load Default.

7. When you’ve finished making changes, click OK.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Remapping a site

You can remap a site after you’ve made changes to it.

To remap a site:

1. Choose Mapping|Remap Site. The Remap Site dialog box appears.

2. Choose your Explore Options, Update Options, and Reporting Options.

3. Select Replace Original Map (and Rename Original “.bak.wmp”) if you want to keep a backup 
copy of your original map.

4. Click OK.

The new map appears in a map window.

RELATED TOPICS
Site Management Tips and Techniques (User’s Guide) 



Using Quick Searches

Site Analyst’s predefined searches offer the easiest and fastest way to search a map. The pre-set
searches are available from the Tools|Quick Search menu.

To use a quick search:

1. Choose Tools|Quick Search.

2. Choose one of the predefined searches from the submenu. For example, click Home Site 
Objects.

Site Analyst searches for pages and other resources on the same domain as the site’s home page. 
The results are displayed in a Search Results window.

RELATED TOPICS
Quick Search descriptions 
Creating Quick Searches 
Searching Maps and Creating Custom Reports (User’s Guide) 



Publishing a map

To publish a map:

1. Open the map you want to publish.

2. Choose File|Publish. The Publish dialog box appears.

3. Specify the path and file name for the published map. The wmp extension is appended 
automatically to the file name.

4. Decide which types of objects you want to include in the published map. Object types that you
don’t include are deleted from the published map.

If you’ve already set up the display options with the object types you want published, 
notice that the Publish dialog box options are automatically set up the same way. Simply click 
OK. The map is compressed and saved in your maps directory, with the name you specify.

If you want to set up different publish options, select Publish All Objects or select 
individual object types in the Publish Only list. (Pages are always published with a map.) You 
can also include alternate routes. Click OK.

Note: If you want to save your customized publish options to use over and over again, click Save
As Default before you click OK to publish the map. Whenever you want to use these options, 
click Load Default.



Adding a default map to your Web site

The default map for your site should meet the following criteria:

· It should be located in your site’s root directory
· It should be named default.wmp
· It should load quickly; that is, it shouldn’t be too large (no more than about 150K)
· It should show the basic structure of your site

To add a default map to your Web site:

1. Make a copy of your published map, and name the copy default.wmp.

2. Put the default.wmp file in the root directory of your site (the directory containing the home 
page).

3. Add the MIME type application/webmap to your Web server, and map the extension wmp to 
this type. You only need to configure the MIME type once.



Creating quick searches

To create a quick (customized) search:

1. Choose Tools|Custom Search or click  on the Main toolbar.

2. Set up the Search dialog box like this (for example):

Search: Entire Map
Object Type: Pages
Field: Load Size
Modifiers: Greater Than or Equal to
Value: 10000

3. Click Save. In the Search Name field, enter a name for this search—for instance, pages100K. 
Notice that your new Quick Search now appears at the top of the Search Type list.

4. Click Search to perform the search.

RELATED TOPICS
Searching Maps and Creating Custom Reports (User’s Guide) 



Setting up the Search dialog box

Use the Search dialog box to specify the search criteria you want. The search criteria you can 
specify includes the following:

Search The part of the map you want to search.

Search Type The type of search you want to use (custom, one of the quick searches, or your 
own customized quick search).

Object Type The type of objects you want to search for.

Field Which of the fields you want to search through.

Modifiers A search option, such as where the text string occurs in the field or whether a 
numeric criterion is greater than or equal to a specified value.

Not A search option, where you can search for criteria that does NOT match the 
specified criteria in the Modifiers box.

Value A text string, or a numeric or Boolean value.

Match Case A search option, where you can exactly match the capitalization of the text string 
specified in the Modifiers box.

RELATED TOPICS
Search dialog box 
Search Results window 



Changing properties and column order in the Results window

To change the properties (and column order) in the Results window:

1. Perform a search operation and have the results window visible.

2. Choose View|Columns|Results Columns (or right-click any column header in the active results 
window, and then choose Columns).The Results Column dialog box appears.

The Show These Properties list box on the right shows the properties (column arrangements) 
that are currently displayed in the results window. The Available Properties scroll list on the left 
shows all available properties, including those that are not relevant to your search.

3. Select a property that you want to add to the column arrangement and click Add. (You can also 
double-click a property to move it, and you can select a group of properties (Ctrl-click each one) 
and then click Add.)

4. You can add all the properties with the Add All button. Likewise, you can remove a property one 
at a time or remove them all and set up your properties and column arrangements from scratch.

5. You can reorder the properties column arrangements by highlighting a property and clicking 
Move Up or Move Down.

6. When you’ve finished making changes and arranging column order, check the Quick Columns 
choice at the top left and choose an object type. Then, click Done.

RELATED TOPICS
Search Results window 
Using Quick Searches 
Setting up the Search dialog box 



Changing how properties are sorted

To change the way properties are sorted in the Search Results window:

Click the column header for the property.

The following changes occur:

Text The text strings will be arranged in alphabetical order. Click the column header again to 
arrange the text strings in reverse alphabetical order.

Dates The dates in the column will be arranged in descending order to show most recent dates 
first. Click the header again to arrange the dates in ascending order (oldest date first).

Numeric The numbers will be arranged in descending order (highest number first). Click the 
column header again to arrange the numbers in ascending order (lowest number first).

Boolean All of the False values will be shown first, then the True values. Click the column header 
again to show the True values first.

RELATED TOPICS
Changing properties and column order in Results window 



Importing usage data

Once you have your log files ready, follow these steps to import the information into your map:

1. Choose File|Import Usage Data. The Import Usage Data dialog box appears.

2. Type or browse for the file name.

3. Select the Referrers Only button to see the URLs that the hits originated from.

4. Select the Referrers and Hits button to see both hits and referrer URLs in your map.

5. Click Replace Previous to see the most recent hit counts (if you’ve imported usage data 
previously).

6. Click Accumulate to see a cumulative total of all hit counts since you first started importing data.

7. Check Set Routes by Hits so that the busiest links have the most prominence in the map 
hierarchy. 

RELATED TOPICS
Site Management Tips and Techniques (User’s Guide) 
Managing Links (User’s Guide) 



Using META tag data in your maps

As long as your META tag NAME attributes are exactly the same as any of the fields on the 
Annotations tab of the Properties dialog box, they will be automatically imported into the 
Annotations tab when you create a map.

If you have META tag data in your map, you can quickly view and search for the CONTENT data.

For example, if you have three META tags like this, the CONTENT data in all three tags will 
appear in the Annotations tab fields with the same names:

<META NAME=”AUTHOR” CONTENT=”Elmo@microsoft.com”>
<META NAME=”DATE” CONTENT=”Fri, 25 Oct 1996 15:56:23”>
<META NAME=”NOTES” CONTENT=”Update graphics ASAP”>

Now this information is part of both your site and the map.

Note that your NAME attribute must be the same as the Annotations tab fields:

Name
Source Path
Author
Date (format is determined by your current Windows setting)
Notes
Private Notes

Note: Site Analyst can only read your META tag information and insert it into the map. It cannot 
write any new data you enter back into your HTML files.

RELATED TOPICS
Annotations tab (Properties dialog box) 



Changing properties and column order in the Link Info window

To change the properties (and column order) in the Link Info window:

1. Right-click any column header in the Link Info window, then choose Columns (or click the 
Columns button). The Configure Columns dialog box appears.

The Show These Properties list box on the right shows the properties (column arrangements) 
that are currently displayed in the Link Info window.

2. From the Available Properties list, select a property that you want to add to the column 
arrangement and click Add. (You can also double-click a property to move it, and you can select 
a group of properties (Ctrl-click each one) and then click Add.)

3. You can add all the properties with the Add All button. Likewise, you can remove a property one 
at a time or remove them all and set up your properties and column arrangements from scratch.

4. You can reorder the properties column arrangements by highlighting a property and clicking 
Move Up or Move Down.

5. When you’ve finished making changes and arranging column order, click Done. The properties 
will be displayed in columns in the order (left to right) you’ve arranged.

RELATED TOPICS
Link Properties 
Managing Links (User’s Guide) 



Comparing and updating maps

To compare and update two maps:

1. Open the two maps you want to compare.

2. If you’re comparing maps of two similar sites, use the Explore command to explore both maps to 
the same level.

3. Choose Tools|Compare and Update or click  on the Main toolbar. The Compare and Update 
dialog box appears.

4. For the Source WebMap, choose the map with customizations you want to preserve, usually the 
older of the two maps.

5. For the Target WebMap, choose the map you want to update with the source map’s 
customizations, usually the newer of the two maps.

6. If you want to see comparison reports, select one or both of the options in the Compare area.

7. To update the target map with the customizations of the source map, select Update Annotations 
from Source WebMap to Target WebMap.

8. Click OK. If you selected either of the Compare options, the appropriate comparison results 
appear: Orphaned Objects window (for the source map) or the Changed and New Objects 
window (for the target map).

RELATED TOPICS
Site Management Tips and Techniques (User’s Guide) 



Changing how alternate routes are displayed

To change how alternate routes are displayed:

1. Choose View|Display Options or click  on the Main toolbar. The Display Options dialog box 
appears.

2. In the Display As section, select the Link Icons button, then click OK.

For more details on each option, click the Help button on the dialog box.

RELATED TOPICS
All About Routes (User’s Guide) 



Resetting the routes

To change the routes:

1. Choose Mapping|Set Routes By.

2. Click the URL Hierarchy button to set routes by the site’s URL hierarchy.

3. Click the Usage Data button to set routes by usage data (hit counts).

4. Click OK.

RELATED TOPICS
All About Routes (User’s Guide) 



Changing the map's local path

To change the map’s local path:

1. Choose Mapping|Mapping Options. The Mapping Options dialog box appears.

2. On the General tab, enter (or browse for) the new local path in the Local Site Root Directory text 
box. 

3. Click OK.

For more details on each option, click the Help button on the dialog box.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Configuring helper applications

To configure helper applications:

1. Choose View|Program Options. The Program Options dialog box appears.

2. Select the Helpers tab. A list of current applications appears in the Helper Applications list.

3. In the Object Type list, choose the type of object you want to configure a helper app for.

4. Click Add. The Add Helper dialog box appears.

5. Enter (or browse for) the executable file of the application that you want to configure.

6. Click OK to return to the Helpers tab.

7. In the Menu Text box, type the name as you want it to appear in the Launch Helper App menu 
(on the Tools menu and right-click menu).

8. In the Parameters box, specify the file information or other parameters required by the 
application.

9. Click Apply or OK.

For more details on each option, click the Help button on the dialog box.

RELATED TOPICS
Site Management Tips and Techniques (User’s Guide) 



Creating an HTML table of contents of your site

To create an HTML table of contents:

1. Set up the map window so that it displays exactly what you want to include in the table of 
contents.

If you want to print the entire map, you should show all objects and use the View|Expand All 
command.

2. Choose File|Export|Tree View. The Export dialog box appears.

3. Choose HTML from the Format list.

4. Use the standard Save dialog box features to specify the name of the HTML file. Site Analyst 
suggests the default file extension .htm.

5. Click Save. The HTML table of contents file automatically loads into your default Web browser.

RELATED TOPICS
Creating and Customizing WebMaps (User’s Guide) 



Creating an HTML index of your site

You can create a hyperlinked index of all the pages in your site. With one click, you can include 
this index as a quick reference to your site.

To create an HTML index of your site:

1. If you didn’t generate HTML reports when you first mapped your site, do so now: Choose Tools|

Generate Site Reports or click  on the Main toolbar.

2. Specify a name and directory for the reports. After a few moments, the Summary Report of your 
site appears in your browser.

3. Click the Index link to display the Page Index.

4. Now click Publishable Version of this Index. This will delete the page icons in the Page Index 
(these icons link to other parts of your site reports, which is probably not useful for the index you 
want to publish).

5. You can now add this index page to your site.

RELATED TOPICS
Using HTML Reports 
Working with HTML reports (User’s Guide 



Using HTML Reports

You can generate site reports as you create a new map, or you can generate reports for a map 
you are viewing.

To generate site reports when you create a map:

1. Choose File|New|Map from URL. The New Map from URL dialog box appears.

2. In the Home Page Address box, enter the URL of the site you want to map.

3. Select the Generate Site Reports checkbox.

4. After specifying the mapping options you want, click OK.

5. In the Generate Site Reports dialog box, specify the location to save the report files. Site Analyst 
automatically names the files with a prefix based on the domain name of the site you’re mapping,
and it appends a suffix that identifies each report file. You can specify a different prefix name in 
the Report Prefix box.

6. To save a copy of the map with the site reports, select the checkbox called Save Copy of Map to 
Report Directory.

7. Click OK.

To generate site reports for a map you’re already viewing:

1. Choose Tools|Generate Site Reports or click  on the Main toolbar. The Generate Site Reports
dialog box appears.

2. Follow the same procedures described above in steps 5, 6 and 7.

RELATED TOPICS
Help on Reports 
Working with HTML reports (User’s Guide) 



Locating links to a changed resource (InLinks)

To locate links to an object that has changed:

1. Select the object (in the map or results window) that changed.

2. Display the Link Info window.

3. Click the InLinks button. All links to the selected object (InLinks) appear in the list.

Note that if the map contains explored offsite links, the Links list could include links from those 
other sites.

4. Select a link that you want to check further, and click Follow. The page where the link originates 
is selected in the map.

5. To display the newly selected page in your Web browser, double-click the object in the map. Now
you can inspect the source page and locate the link in question.

6. If you need to change or delete the link because it’s no longer appropriate, launch your helper 
application to edit the source page.

Note: Be sure to fix any newly broken links before you remap the site. Otherwise, the currently 
unavailable object won’t appear in the map.

RELATED TOPICS
Managing Links 
Site Management Tips and Techniques (User’s Guide) 



Locating orphans

To see pages that have links to an orphaned object:

1. Perform a Compare and Update operation: Click  on the toolbar or choose Tools|Compare 
and Update.

2. In the Compare and Update dialog box , select Show “Orphaned Objects” Results Window.

3. In the Orphaned Objects results window, right-click the object and choose Links. The Link Info 
window appears.

4. Select the InLinks button. All links to the selected object appear in the Links list.

5. To inspect the orphaned page to see if it’s really a resource that doesn’t belong in the site 
anymore, simply double-click the object in the results window to display it in your browser.

RELATED TOPICS
Managing Links 
Site Management Tips and Techniques (User’s Guide) 



Verifying offsite links

To verify offsite links during site exploration:

1. When you create a map, or when you use the Explore command on an existing map, click the 
Options button. The Mapping from URL Options dialog box appears.

2. On the General tab, select Verify Offsite Links.

3. Click OK. As it explores the site, Site Analyst checks to see if the object that each offsite link 
points to exists and is reachable. If an object is unavailable, all links to it in the map are 
displayed in red.

To verify offsite links without exploring:

1. Choose Verify Links from the Mapping menu or click  on the Main toolbar. The Verify Links 
dialog box appears.

2. Select Offsite Links.

3. If you want to verify all offsite links, click the All Links button.

4. If you want to re-verify only those offsite links that were broken the last time you verified them, 
click Broken Links Only.

5. Click Verify. Any offsite links that are displayed in red are either unavailable or the links to them 
are truly broken.

Note: The newly verified objects still have a question mark icon. Even though Site Analyst has 
verified that the objects exist, it hasn’t yet explored them.

RELATED TOPICS
Managing Links (User’s Guide)  



Object and route label colors

The various colors in Microsoft maps help you quickly recognize what kind of object you're 
looking at. 

This Color            Identifies
Black Onsite, main routes through the site. See "Main and alternate routes (black and green 

labels)," in the User’s Guide (“Anatomy of a WebMap”).
Blue Offsite objects.
Green Alternate routes to an object. See "Main and alternate routes (black and green labels)," in the

User’s Guide (“Anatomy of a WebMap”).
Red An unavailable object (broken hyperlink, unavailable server, and so on); red overrides any 

other color assignment
Magenta The selected object, in the Cyberbolic view only. 

Also, the most-used routes (busiest links) are shown with magenta lines between objects 
(only in Cyberbolic view). This feature is available only if you’ve imported usage data into 
your map; see section 8.2, "Importing usage data," in the User’s Guide for details.

Cyan The home page, in the Cyberbolic view only.

RELATED TOPICS
Anatomy of a WebMap 
Site Management Tips and Techniques 





Cyberbolic Tasks

Choose from the following list for instructions on these tasks:

About Cyberbolic view 

Changing the Cyberbolic pop-up label 

Changing the label font size in Cyberbolic view 

Changing the orientation in Cyberbolic view 

Changing the node distance in Cyberbolic view 

Showing the busiest link in Cyberbolic view 

Centering the selected object in Cyberbolic view 

Enabling snap mode in Cyberbolic view 

Exploring a page in Cyberbolic view 

Showing the common ancestor 

Tips for using Cyberbolic view 



About Cyberbolic view
The Cyberbolic view, shown in the right pane of the map window, represents the Web site as just 
that--a web of relationships among pages and other site resources. When you click an object in 
the Cyberbolic view, it moves to the center of the pane (unless you specify otherwise), and the 
objects linked to it fan out accordingly. Unlike the Tree view, the Cyberbolic view is not linear. Its 
strength lies in the way it helps you immediately grasp the layout of a Web site. It’s also very 
helpful if you’ve imported usage data, since it shows the busiest links in a different color. Because
of its web-like nature, the best way to understand the Cyberbolic view is just to play with it.
Since the Cyberbolic view is most useful for giving you a quick, global view of a site, by default it 
shows only pages, and no alternate routes. (You can change what’s shown by adjusting display 
options. This default scheme reduces clutter and allows more room for page labels. When other 
site objects--such as graphic files--are shown, every object except pages is shown with an icon 
that identifies its type, and with a descriptive label. Additionally, the Cyberbolic view offers a pop-
up label that appears when you move your cursor over an object. (The pop-up labels are handy 
because they provide the full text of an object's label, which may be truncated in the other labels.)
You can change both labels independently. 

There are no plus or minus icons in the Cyberbolic view. All children are always shown (the map 
is always fully expanded), so there is no concept of expanding or collapsing the map in this view. 
Question mark icons are shown in the Cyberbolic view, but--unlike in the Tree view--are not 
clickable. In the Cyberbolic view, question mark icons are just an indication of which pages are 
unexplored; explored pages, or pages without children, have no question mark. 

There are a number of ways you can tailor the Cyberbolic view to your liking. Cyberbolic options 
are available from several places:

· View menu: Choose Display Options, then the Cyberbolic tab.
· View menu: Choose Label Options, then change options for the Cyberbolic pop-up label.
· View menu: Choose Program Options, then the Cyberbolic tab.
· Right-click anywhere in the Cyberbolic view for a menu of options.
· Click buttons on the Cyberbolic toolbar.

RELATED TOPICS
About Tree view

Changing object labels 

Changing display options 

Anatomy of a WebMap (User’s Guide)



About Tree view
The Tree view, shown in the left pane of the map window, is similar to an outline or a family tree. 
If you've used the Windows Explorer or File Manager, you'll find that the Tree view works in much
the same way. In the Tree view, pages and other Web site resources are shown in a linear 
hierarchy, with the home page at the top. The children of the home page--that is, pages and other
resources linked to that page--are shown indented beneath the home page, the grandchildren of 
the home page are shown a level down from there, and so on.
In the Tree view, every object in the map has an icon associated with it that gives you a hint 
about what type of object it is. For example, a page has an icon of a sheet of paper. Also, every 
object has a label (some text that describes the object). 
In this view, some pages might have control icons next to them. Control icons appear as plus 
signs, minus signs, or question marks. For more information about control icons, see the Related 
Topics section (below) for the User’s Guide.

RELATED TOPICS
About Cyberbolic view

Changing object labels 

Anatomy of a WebMap 

 



Changing the Cyberbolic pop-up label

To change the Cyberbolic pop-up label:

1. Choose View|Label Options or click  on the Main toolbar. The Labels dialog box 
appears. 

In the Cyberbolic Pop-Up area, there are two buttons:

Use Node Label (which means to use the same label settings you’re using for the 
“main” label)
Use Alternate Label (which means to use a different label, the choices of which are 
in the list).

2. Click Use Alternate Label.

3. Choose the type of label you want.

4. Click OK.

RELATED TOPICS
Labels dialog box 



Changing the label font size in Cyberbolic view

To change label font size:

1. Choose View|Display Options or click  on the Main toolbar. The Display Options 
dialog box appears.

2. Select the Cyberbolic tab.

3. In the Font Size drop-down box, select the font size you want, either small, 
medium, or large.

4. Click OK.

RELATED TOPICS
Cyberbolic tab (Display Options) 



Changing the orientation in Cyberbolic view

The Cyberbolic view can be displayed in one of two ways:

· With the home page at the left side of the Cyberbolic pane and with the other pages fanning 
out to the right (the default).

· With the home page at the center of the pane and the other pages fanning out all around it.

To change orientation:

1. Choose View|Display Options or click  on the Main toolbar. The Display Options 
dialog box appears.

2. Select the Cyberbolic tab.

3. In the Font Size drop-down box, select the font size you want, either small, 
medium, or large.

4. Click OK.

Shortcut: On the Cyberbolic toolbar, click  for center orientation, or click 

 for left orientation.

RELATED TOPICS
Cyberbolic tab (Display Options) 



Changing the node distance in Cyberbolic view

To specify how far apart you want to display map objects:

1. Choose View|Display Options or click  on the Main toolbar. The Display Options 
dialog box appears.

2. Select the Cyberbolic tab.

3. In the Node Distance field, move the indicator between Near and Far until the 
distance between objects is adjusted to your liking.

4. Click OK.

Shortcut: Click  on the Cyberbolic toolbar to bring up the Node Distance dialog box. Slide the
indicator between Near and Far until the distance between objects is adjusted to your liking.

RELATED TOPICS
Cyberbolic tab (Display Options) 



Showing the busiest link in Cyberbolic view

If you’ve imported usage data into your map, you can choose to display the busiest links between
objects in your site with a special color—magenta—in Cyberbolic view.

To show the busiest link:

1. Choose View|Program Options. The Program Options dialog box appears.

2. Select the Cyberbolic tab.

3. Make sure the Show Busiest Link checkbox is selected.

4. Click OK.

Hint: If you don’t see magenta lines where you think you should, try turning on the display of 
alternate routes in the Display Options dialog box. It’s possible the busiest routes are not on the 
main route.

Note: If you don’t want the busiest links to be shown, clear this option.

RELATED TOPICS
Cyberbolic tab (Program Options dialog box) 
Site Management Tips and Techniques (User’s Guide) 



Centering the selected object in Cyberbolic view

By default, the object you select moves to the center of the view when you click it. If, for some 
reason, this is not the case, follow these steps to center the selected object.

To center the object:

1. Choose View|Program Options. The Program Options dialog box appears.

2. Select the Cyberbolic tab.

3. Select Center Selected Node on Mouse Click.

4. Click OK.

Note: If you don’t want the selected object to be centered, clear this option.

RELATED TOPICS
Cyberbolic tab (Program Options dialog box) 



Enabling snap mode in Cyberbolic view

By default, the selected object glides to its new position; you can see the motion when a newly 
selected object moves to the center of the view. If you prefer, you can enable snap mode so that 
the objects appear immediately in their new positions.

To enable snap mode:

1. Choose View|Program Options. The Program Options dialog box appears.

2. Select the Cyberbolic tab.

3. Select Enable Snap Mode.

4. Click OK.

Shortcut: Click  on the Cyberbolic toolbar.

RELATED TOPICS
Cyberbolic tab (Program Options dialog box) 



Exploring a page in Cyberbolic view

To explore a page:

1. In Cyberbolic view, right-click an object that has a question mark.

2. Choose Explore Page.

The page is explored in both views: in Cyberbolic view, the object is selected, its 
label is changed, and its children are now displayed. In Tree view, the object is 
selected, and the question mark icon is changed to a plus sign. You can click the 
plus sign to expand the object in Tree view.



Showing the common ancestor

The Cyberbolic and Tree views stay in sync when you select objects. If you select two objects 
that are far away from each other, it is sometimes difficult to see their relationship in either view.

If you’re using both views, you can set Cyberbolic view to so that it shows the nearest common 
ancestor before it displays the selected object. That way, as you select objects in Tree view, the 
Cyberbolic view will pause its movement briefly to highlight the common ancestor before settling 
on the currently selected object.

To show the common ancestor:

1. Choose View|Program Options.

2. Select the Cyberbolic tab.

3. Check Enable Common Ancestor Transition.

4. Clear Snap Mode if it is checked.

5. Click OK.

RELATED TOPICS
Cyberbolic tab (Program Options dialog box) 



Tips for using Cyberbolic view

· To bring an object into focus, click its label.
· Consider showing fewer objects in Cyberbolic view than in Tree view. You’ll get a better 

global perspective on the site you’re viewing.
· When you double-click an object, that object appears in your browser. If you move your 

mouse slightly between clicks, the first click determines which object is displayed in the 
browser.

· If you click overlapping items, the object on top becomes active.
· The pop-up labels let you view the entire text in the label.
· Use Snap Mode to speed up navigation and avoid watching the shifting of the map that 

occurs if you’re jumping rapidly from one object to another in Tree view or in the browser.
· If you select an object in Tree view that isn’t currently visible in Cyberbolic view, the object’s 

nearest “ancestor” (usually its parent or grandparent) is selected in Cyberbolic view.



Toolbar buttons

Main toolbar buttons Cyberbolic toolbar buttons

Opens an existing map file. Expands the Cyberbolic view to occupy the 
entire map window.

Saves the current map file with the 
current file name.

Displays both the Tree and Cyberbolic views in 
the current map window.

Changes how objects are displayed in 
the Tree view and Cyberbolic view.

Displays the home page on the left of the 
Cyberbolic view.

Changes the labels used for the 
displayed objects in Tree view and the 
pop-up labels for Cyberbolic view.

Displays the home page in the center of the 
Cyberbolic view.

Explores a site to the page and level 
limits that you specify.

Enables and disables snap mode.

Searches for specified objects in the 
map.

Brings the home page back to its central 
position (either center or left, depending on 
your settings).

Compares two maps or updates one 
map from another map.

Determines the distance between the nodes.

Displays map statistics.

Shows properties of the selected 
object.

Displays the Microsoft Site Analyst 
contents screen.




